Exploring Data with TinkerPlots™

Clifford Konold

Key Curriculum Press
Innovators in Mathematics Education
# Contents

**Introduction** ............................................................................................................ v

**Getting Started** ........................................................................................................ 1
Install ............................................................................................................................ 1
Install on Multiple Computers .................................................................................. 1
Register ...................................................................................................................... 2
Start TinkerPlots ....................................................................................................... 2
Watch the Introductory Movie ................................................................................... 2
Open a Sample Document ....................................................................................... 3
Use Help ..................................................................................................................... 3
Get Technical Support ............................................................................................. 3

**Learning TinkerPlots** ............................................................................................. 4
Movies ....................................................................................................................... 4
Data Sets .................................................................................................................... 5
Demonstrations ......................................................................................................... 7

**Teaching with TinkerPlots** .................................................................................... 9
Why Have Students Explore Data? ............................................................................ 10
Research on Student Thinking About Data ............................................................ 11
Using TinkerPlots in Different Classroom Settings ............................................. 13
Using the Activities .................................................................................................. 14
Getting the Most from Written-Response Questions ............................................ 15
Using the Data Sets and Demonstrations ............................................................... 16
Making and Researching Your Own Data ............................................................... 17
Sharing Data with Other Classes ........................................................................... 18

**Activities** ............................................................................................................... 19
Who Has the Heaviest Backpacks? .......................................................................... 21
Is Your Backpack Too Heavy for You? .................................................................... 23
Factors ....................................................................................................................... 26
Number Properties .................................................................................................... 29
Men’s 100-Meter Dash at the Olympics ................................................................. 32
Men and Women at the Olympics ......................................................................... 35
The Yo-Yo Mystery ................................................................................................... 37
<table>
<thead>
<tr>
<th>Activity Notes</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who Has the Heaviest Backpacks?</td>
<td>43</td>
</tr>
<tr>
<td>Is Your Backpack Too Heavy for You?</td>
<td>46</td>
</tr>
<tr>
<td>Factors</td>
<td>49</td>
</tr>
<tr>
<td>Number Properties</td>
<td>52</td>
</tr>
<tr>
<td>Men’s 100-Meter Dash at the Olympics</td>
<td>56</td>
</tr>
<tr>
<td>Men and Women at the Olympics</td>
<td>59</td>
</tr>
<tr>
<td>The Yo-Yo Mystery</td>
<td>62</td>
</tr>
</tbody>
</table>
Introduction

TinkerPlots™ Dynamic Data Exploration is a data analysis program designed specifically for students in grades 4–8. With it, students can enter data they collect themselves or find on the Internet, and can create their own graphs or tables of these data. They can also use TinkerPlots to produce reports that include these graphs, along with text that explains their findings and even photos they take or locate on the Internet.

What makes TinkerPlots different from any other “graphing” or spreadsheet program is that, with TinkerPlots, students actually design their own graphs. This gives them a sense of being in control of what they produce.

Like a word-processing or spreadsheet program, TinkerPlots is a general tool that teachers and students alike will find useful across a large range of subject matter. It comes with a variety of ready-to-analyze data sets, drawn from topics including mathematics, science, history, geography, health studies, sports, and more.

In this book you’ll find suggestions on getting started, details on what comes with TinkerPlots, and information on how to teach with TinkerPlots. The book includes seven sample activities, with activity notes, that you can use to introduce TinkerPlots and data exploration to your students.

The Relationship of TinkerPlots to Fathom

TinkerPlots shares many features with the software package Fathom Dynamic Data™. Fathom is a data analysis program designed for high school and introductory college courses. Those of you who are familiar with Fathom will recognize many features the two programs share. The case table in TinkerPlots is in fact nearly identical with Fathom’s case table. Text boxes, sliders, and the formula editor are also objects that TinkerPlots and Fathom have in common. Functions such as printing, exporting, and saving are all Fathom routines used by TinkerPlots.
Getting Started

Install

Windows
1. Insert the TinkerPlots CD-ROM into your CD drive.
2. Double-click the My Computer icon on your desktop.
3. Double-click the CD icon. (It may be labeled either D: or TinkerPlots.)
4. Double-click the Setup icon and follow the instructions on the screen.

Macintosh
1. Insert the TinkerPlots CD-ROM into your CD drive.
2. Double-click the CD icon.
3. Double-click the Installer icon and follow the instructions on the screen.

Install on Multiple Computers

There are two possible configurations for installing a TinkerPlots multi-user edition: Install on each computer or install on a network server. (The type of license you bought specifies how many computers you have permission either to install or to run TinkerPlots on.) It is less work to install and upgrade only on a server, though it will slow performance (by how much will vary depending on the speed of your computers).

Installation is similar for all: Insert the CD-ROM, double-click the installer, and follow the instructions on the screen. At the end, you have a choice of restarting or not restarting the computer.

To Install on Each Computer

Use the TinkerPlots CD-ROM to install TinkerPlots onto each computer for which you are licensed.

Insert the CD-ROM into a computer’s CD drive, open it, double-click the installer, follow the instructions on the screen, and restart when you’re through.

Or,

Use the CD-ROM in the server’s CD drive to install onto each machine for which you are licensed (this is faster than the previous method, because you can install on more than one machine simultaneously).

Insert the CD-ROM into the server’s CD drive and give sharing privileges for each machine. From each computer, access the server’s CD drive,
**Getting Started (continued)**

double-click the installer, follow the instructions on the screen, and restart when you’re through.

**To Install on the Server**

Insert the CD-ROM into the server’s CD drive, open it, double-click the installer, and follow the instructions on the screen. At the end, you will be asked whether you want to restart the computer (your choice).

Make sure the TinkerPlots folder is shared to each computer for which you are licensed, by whatever method you usually use to share networked software.

You may want to put shortcuts or aliases to TinkerPlots on each networked computer.

*Note:* All installed sample documents are locked so that students cannot easily save over them. When students try to save, they will be prompted with a **Save As** dialog box. They must rename or move the file in order to complete the save.

**Register**

When you register your TinkerPlots software, you’ll receive email notifying you of free software updates. You’ll be asked to register during the installation process. This will launch your Web browser and take you to the TinkerPlots Resource Center. Or you can simply go to www.keypress.com/tinkerplots/register.

**Start TinkerPlots**

After you have installed TinkerPlots from the CD-ROM, the TinkerPlots icon should appear on your desktop. Double-click it to start the program.

If the icon is not on your desktop, you can probably find the **TinkerPlots** folder in the **Program Files** folder of your startup disk (Windows) or directly on your hard drive (Macintosh). If you can’t find it, do a search on the name TinkerPlots.

**Watch the Introductory Movie**

The best first introduction to TinkerPlots is a five-minute movie called *TinkerPlots Basics*. To watch this movie, choose **TinkerPlots Movies** from the **Help** menu, then **TinkerPlots Basics** from the Movies page. The movie is in QuickTime MOV format or Microsoft AVI format. On this page you’ll also see several other movies, but we recommend that you experiment with the software before viewing them. For more details on the movies, see page 4.
Getting Started (continued)

Open a Sample Document

TinkerPlots comes with many interesting data sets and demonstration documents. You can find details on these documents on pages 5–7.

To open one of the sample documents,

1. Open the folder **Data and Demos** and then any subfolder.
2. Double-click one of the TinkerPlots files (these have the suffix .tp).

Or with TinkerPlots running,

1. Choose **Open** from the **File** menu.
2. Locate the folder **Data and Demos**.
3. Locate the file you want and click **Open**.

Use Help

To find out something you don’t know, use the TinkerPlots help system. Choose **TinkerPlots Help** from the **Help** menu. The Help will launch in your Web browser.

If you would like to print a copy of TinkerPlots Help, open and print the file **TinkerPlots Help.pdf**. This file is located in the **TinkerPlots \ TinkerPlots Help** folder on your hard drive. It requires Adobe® Reader®, available free from Adobe.

The Quick Reference card can also help you with basic questions. To print more copies of the Quick Reference, go to the **TinkerPlots \ TinkerPlots Help** folder and open the file **Quick Reference.pdf**.

If you want instruction on certain general topics, you can also choose **TinkerPlots Movies** from the **Help** menu, and then the topic you want from the Movies page. The movies are in QuickTime MOV format or Microsoft AVI format.

Get Technical Support

When something goes wrong and you need support, here are some things you can do.

- Check the TinkerPlots Web site at www.keypress.com/tinkerplots. Here you will find answers to frequently asked questions and the latest updates to the program. You can also check for updates by choosing **Check for Updates** from the **Help** menu.
- Fill out an online technical support form at the TinkerPlots Web site.
- Call our technical support line at Key Curriculum Press, 510-595-7000. We can be most helpful to you if you are sitting in front of a computer with TinkerPlots running.
Learning TinkerPlots

TinkerPlots includes several different resources to help you learn the program and what you can do with it. The best way for you and your students to learn the basics of TinkerPlots is to watch the introductory movie. Choose TinkerPlots Movies from the Help menu, and then TinkerPlots Basics from the Movies page. After you’ve watched the movie you’ll be able to dive right into a data set and probably figure out many things on your own. You can use the Quick Reference card to answer some basic questions. We’ve also included other movies that can give you simple instruction on a variety of topics, many sample data sets that you and your students can explore, and demonstrations that show some of the different capabilities of TinkerPlots. If you need help on a specific topic, you can look it up in the help system by choosing TinkerPlots Help from the Help menu.

Movies

TinkerPlots comes with five short movies providing basic instruction in the software. Each movie is about five minutes long. The movies are provided in QuickTime MOV format and Microsoft AVI format. Below we’ve provided details on what each movie covers. To watch a movie, choose TinkerPlots Movies from the Help menu, and then choose the topic you want from the Movies page. The movie will be played in your Web browser.

TinkerPlots Basics
Learn to build and color graphs, and add features such as reference lines and averages.

Adding Data
Learn to type new data, copy and paste data from Microsoft Word and Excel, download data from the Internet, and detect and solve some common problems such as missing cases and ill-formed attributes.

Making Common Graphs
Learn to make common graphs and tables, such as dot plots, histograms, value bar graphs, and pie graphs, as well as transform one to another in ways that will help students make connections between them.

Comparing Groups
Learn to explore differences between two groups by using slices, dividers, averages, and hat plots, as well as how to use the Drawing tool to emphasize important features of the data.
Exploring Relationships

Learn to explore relationships among data by superimposing color gradients, using fused and borderless icons, making and interpreting scatter plots and binned scatter plots with averages, adjusting bin lines, and fitting a curve by eye with the **Drawing** tool.

### Data Sets

TinkerPlots includes about 40 ready-to-analyze data sets, on topics ranging from science and math to history and sports. Each data set includes a few sample questions to get you started. Following is a short description of each data set. Data sets marked with an * are more suitable for older students or teachers. See pages 16–17 for advice on how to use the data sets with students. To open a data set, go to a subfolder in the TinkerPlots | Data and Demos folder and double-click a file.

#### Health

<table>
<thead>
<tr>
<th>Data Set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baby Boom.tp</td>
<td>Gender, time of birth, and birth weight of 44 Australian babies, 1997</td>
</tr>
<tr>
<td>Backpacks.tp</td>
<td>Grades, body weight, and backpack weight of 79 U.S. students</td>
</tr>
<tr>
<td>Body Measurements.tp</td>
<td>Body measurements, such as wrist and elbow, of 507 U.S. adults</td>
</tr>
<tr>
<td>Cereals.tp</td>
<td>Nutritional information for 77 breakfast cereals</td>
</tr>
<tr>
<td>Child Development.tp</td>
<td>Body measurements, such as weight and height, for 136 U.S. children at three different ages, 1928–1947</td>
</tr>
<tr>
<td>Male Measurements.tp</td>
<td>Body measurements, such as body fat and neck circumference, of 252 men</td>
</tr>
<tr>
<td>Reaction Times.tp</td>
<td>Reaction times of 235 visitors to the Museum of Science in Boston, MA</td>
</tr>
<tr>
<td>Running Times.tp</td>
<td>One man’s times running a 3.3 mile course, 1990–1992</td>
</tr>
</tbody>
</table>

#### Science and Nature

<table>
<thead>
<tr>
<th>Data Set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 Cats.tp</td>
<td>Body measurements, such as weight and tail length, of 100 cats</td>
</tr>
<tr>
<td>Cats.tp</td>
<td>Body measurements, such as weight and tail length, of 24 cats</td>
</tr>
<tr>
<td>Dinosaurs.tp</td>
<td>Characteristics, such as diet and size, of 28 types of dinosaurs</td>
</tr>
</tbody>
</table>
Learning TinkerPlots (continued)

<table>
<thead>
<tr>
<th>Dataset Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eagle Migration.tp</td>
<td>Migration path of a bald eagle, 1999–2000</td>
</tr>
<tr>
<td>Earthquakes.tp</td>
<td>Characteristics of 590 earthquakes of magnitude 6 or higher, 2000–2003</td>
</tr>
<tr>
<td>Elements.tp</td>
<td>Characteristics, such as atomic number and boiling point, of 112 elements of the periodic table</td>
</tr>
<tr>
<td>January Temps.tp</td>
<td>Average minimum January temperature of selected U.S. cities, 1931–1960</td>
</tr>
<tr>
<td>Judging Weight.tp</td>
<td>Results of 34 adults estimating a quarter of a pound of candy</td>
</tr>
<tr>
<td>Mammals.tp</td>
<td>Characteristics, such as life span and daily hours of sleep, of 27 types of mammals</td>
</tr>
<tr>
<td>Nenana Ice Classic.tp</td>
<td>Dates of the ice break up on Alaska’s Tanana River, 1917–2004</td>
</tr>
<tr>
<td>Numbers.tp</td>
<td>Characteristics of whole numbers 1–100</td>
</tr>
<tr>
<td>Old Faithful.tp</td>
<td>222 eruptions of Old Faithful, a geyser in Yellowstone National Park, 1978–1979</td>
</tr>
<tr>
<td>*Ozone Levels.tp</td>
<td>Ozone levels in New York City in the summer of 1973</td>
</tr>
<tr>
<td>Planets.tp</td>
<td>Characteristics, such as length of year and radius of orbit, of the 9 planets</td>
</tr>
<tr>
<td>South Pole.tp</td>
<td>Monthly temperatures at the South Pole, 1957–1988</td>
</tr>
<tr>
<td>*Space Station.tp</td>
<td>Hourly measurements of humidity and temperature taken aboard the International Space Station in April, 2002</td>
</tr>
<tr>
<td>Vegetables.tp</td>
<td>Characteristics, such as germination time and calories, of 39 types of vegetables</td>
</tr>
</tbody>
</table>

**Social Studies**

<table>
<thead>
<tr>
<th>Dataset Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australian Students.tp</td>
<td>Survey of 159 Australian high school students, 2003</td>
</tr>
<tr>
<td>Car Speed.tp</td>
<td>Speed of 60 cars on a Massachusetts highway, 2000</td>
</tr>
<tr>
<td>New Zealand Students.tp</td>
<td>Survey of 199 New Zealand middle-school students</td>
</tr>
<tr>
<td>Tall Buildings.tp</td>
<td>Characteristics, such as year built and country, of the 100 tallest buildings in the world, 2004</td>
</tr>
</tbody>
</table>
## Learning TinkerPlots (continued)

*US Cities.tp  
Characteristics, such as population and median age of residents, of 146 U.S. cities, 1990–2000

US Presidents.tp  
Characteristics, such as age when taking office and birth state, of 43 U.S. presidents, 1789–2004

*US States.tp  
Characteristics, such as average annual rainfall and average teacher’s salary, of the 50 U.S. states, 1988–2002

US Students.tp  
Survey of 82 U.S. high school students, 1990

Wages.tp  
Occupational information, such as years of education and experience, for 534 U.S. adults, 1985

### Sports and Entertainment

Basketball.tp  
Career statistics of 75 players in the Basketball Hall of Fame, 1959–2003

NY Marathon.tp  
Winning times for men and women in the New York City marathon, 1970–2004

Olympics W vs M.tp  
Olympic gold-medal times and distances for men and women in four track-and-field events, arranged to aid comparison between men and women, 1896–2000

Olympics.tp  
Olympic gold-medal times and distances for men and women in track-and-field events, 1896–2000

Oscars.tp  
Ages of Academy Award winners for Best Actress and Best Actor, 1928–2003

### Exploring Data Starters

These are documents specifically designed for use with the activities in this book. See the Activity Notes for details. Most of these documents contain the same data as documents described above, but are formatted for use with the activity.

### Demonstrations

TinkerPlots includes nine demonstrations, each designed to show possible ways to use TinkerPlots. Some are suggestions for class activities, while others show ways to use sliders and filters to animate data. A sample
Learning TinkerPlots (continued)

student report is also included. To open a demonstration, go to the Data and Demos | Demos folder and double-click a file.

Add Integer Demo.tp
Help students see how adding to or changing a value in a histogram affects the value of an average such as the mean or median.

Backpack Report.tp
A sample student report for the Backpacks.tp data set. The report is based loosely on a report written by students who collected similar data at the Germantown Academy in Pennsylvania.

Fish Experiment Demo.tp
Demonstrate that small random samples already show certain features of the larger population, such as where the data tend to be centered.

Medical Test Demo.tp
Illustrate why false positives are so common in medical screening tests. Change disease and test accuracy rates to show their effects on the probability of false positives.

Power Functions Demo.tp
Show the effects of varying parameters on power functions.

Random Samples Demo.tp
Learn how to draw random samples from a data set.

Slider and Filter Demo.tp
Learn four ways to use sliders, filters, and formula-defined attributes to animate graphs: add cases to a plot according to their value for a numeric or category attribute, add cases to a plot that are randomly drawn from the collection, or make a plot containing a random sample of the cases and look at another random sample of the same size.

Sample Means Demo.tp
Illustrate the stability of sample means, both as a sample grows, and for different samples.

Yo-Yo Master.tp
Use this document to change the time of the break-in for the activity The Yo-Yo Mystery (see page 37). Or illustrate how growing the sample over time can help students locate the time of the break-in.
Exploring real data with TinkerPlots brings data alive for students. Trying different plots to explore a question of interest helps students get a sense for how graphs of different types emphasize different features of the data. It can also build a sense as to why certain types of graphs are considered standard. Getting this sense of data is useful in many different fields of study, including science, history, geography, health studies, and many others.

In teaching with TinkerPlots, try not to rush ahead. First make sure that students have a specific question they want to explore, and then let them think about and explore the data on their own. Each data set includes one or two questions that students can get started with. Starting with a common question is important and helps to focus their activity. Part of what excites students when many of them are in the same room, each exploring the same question, is the variety of TinkerPlots graphs they see when they look around them. All these graphs are supposedly answering the same question! This variety sends them the message that with TinkerPlots, they have to make decisions about how to graph their data. There is space for them to be creative. There are no menus of plot types that directly give them “official” graphs. Students need to take charge, and they do.

TinkerPlots has been widely field-tested in grades 4–8. We would also guess that students in grade 3 would do fine with the right data sets (for example, Cats.tp or Backpacks.tp). More than the workings of the software, we find it is the particulars of the data set and the questions you ask about the data that make or break a data exploration for students (see Making and Reseaching Your Own Data on page 17). Older students can also use TinkerPlots to deepen their understanding of data analysis. Having to create plots from scratch can also help high school students understand what the “standard” graphs (for example, histograms, bar graphs, and box plots) are truly doing to data.

This book contains seven activities that you can use to get students started on TinkerPlots. Each activity is self-contained so they can be done in any order, although some of the activities do build on each other. Before working with TinkerPlots, students should watch the short introductory movie (see page 2). This will show them TinkerPlots basics. We’ve found that after watching this movie, students can do any one of these activities with no additional support. However, you may want to have one or more Quick Reference cards available to answer any questions they might have. To print additional Quick Reference cards available to answer any questions they might have. To print additional Quick Reference cards, go to the TinkerPlots Help folder and double-click Quick Reference.pdf. Once your students are familiar with TinkerPlots, you can have them work through an appropriate data set (see Using the Data Sets and Demonstrations on page 16).
Teaching with TinkerPlots (continued)

In each activity, students learn about the context of the data, make a hypothesis about what the data might show, then investigate their hypothesis, and finally write up their conclusions. We recommend using this general method with any data set you have students explore. This helps students understand what they are looking at, engages them in the data, builds their reasoning, writing, and critical thinking skills, and gives them a common experience that can serve as basis for a class discussion.

Encourage students to think beyond what the data show to what might explain the pattern or trend in the data. For example, with the data set Backpacks.tp, it is relatively easy to make graphs showing that older students carry heavier backpacks. But encourage students to go beyond the graph to think about “why.” If asked, they will probably be able to offer many reasons for why older students carry more. As a follow-up, you might want to help them think about additional surveys or studies that help support their conjectures about “why.” For example, if students think that older students have more books, they could collect data about the number of books used in different grades. Or if they think the books used in higher grades are heavier, they could measure the weights of the books used in different grades. Even if they don’t actually do these studies, it is an important skill to be able to think about the kind of data we would need to test our conjectures.

Why Have Students Explore Data?

In today’s world, all of us need to know how to reason about data. Data are literally all around us. “Data literacy” is required in many jobs and professions, and it can help us make many personal decisions. (Which car should I buy if I am most concerned about safety? What colleges should I apply to? Are there health benefits to taking vitamin supplements?) Of course, most of us can get by without looking at data to make these decisions. But today, an informed citizen needs to be able to reason about data, to look at graphs and evaluate the soundness of conclusions based on them.

Think for a moment about the issues we currently face as a nation and world, questions about the environment, health care, public safety, and equity. In each of these situations, there is a large amount of data that we have collected. We are trying to figure out what it means and what we should do. In the case of global warming, over 100 years’ worth of temperatures from various parts of the world appear to be on an upward warming trend. We also know that over this same period we have pumped an increasing amount of hydrocarbons into our environment. Are these two trends related, and if so, what do we do?

And think of all the numbers you are given by the person or party asking for your vote. Where did the numbers come from and what do they mean? The better each of us can answer these questions, now and in the future, the healthier our political system will be.
It is largely for these reasons that the National Council of Teachers of Mathematics, the National Science Education Standards, and the National Standards for History all have emphasized the importance of our students learning how to evaluate arguments using available evidence, including evidence from data.

**Research on Student Thinking About Data**

During the last ten years, statistics educators have learned quite a bit about how younger students learn to reason about data, and how experts approach data differently from ordinary people or novices. This research influenced both the design of TinkerPlots and the type of data and activities included with it. Here we briefly describe some of what we have learned from research and how we’ve applied it to TinkerPlots. For a more detailed description of this research, see Chapter 13 of *A Research Companion to Principles and Standards for School Mathematics* (2003) published by the National Council of Teachers of Mathematics (NCTM). Other research articles are listed in the TinkerPlots Online Resource Center at www.keypress.com/tinkerplots.

**Developing an Aggregate View of Data**

Experts look at a group of data as a collection, or *aggregate*. When they look at a histogram or stacked dot plot, for example, they tend to see its general shape, how spread out it is, and where the data are centered. When experts compare two groups (say two different stacked dot plots showing people’s heights) they generally base those comparisons on these aggregate features. For example, an expert looking at two distributions of height for men and women might conclude that men tend to be taller than women by comparing the locations of the centers (for example, the means) of each distribution.

Students new to the study of data tend not to see these aggregate features. Rather they see individual cases or subgroups of individuals with the same, or nearly the same, value. Looking at the same distribution of height, students might focus mostly on individuals on the extreme ends of the distribution. Alternatively, they might tend to see short people, average people, and tall people, and reason about these as three different groupings. When students compare two groups, they often compare the number of cases at one of the extreme ends of the distributions. For example, a student looking at a graph showing men’s and women’s heights might argue that the men are taller because there are more of them above 6 feet. One problem with this comparison is that it doesn’t take into account the number of cases in each group. If we had a group of 1000 women and 10 men, we would probably have more women than men above 6 feet. This method of comparing numbers in common slices of the distributions often leads to faulty conclusions.
Researchers have also found that it usually isn’t fruitful to simply tell students that what they are doing is wrong and to recommend an alternative. If students don’t understand why their methods are flawed and why the alternative is better, they will do what you ask now, but later revert to what makes more sense to them. This research led us to take a different approach in TinkerPlots. We have included tools students can use to look at and compare graphs using their intuitive methods. For example, students can use dividers and reference lines to break up distributions into parts and click a button to quickly get counts of cases in different parts. We believe that by allowing students to use methods that make sense to them, and having them discuss what they do with other students and with teachers, they will come to see the limitations in their approaches and develop more powerful methods.

Describing Centers of Distributions

Rather than using means and medians to summarize numeric data, researchers have reported that most people, including young students, prefer to describe a distribution using a “center clump”: for example, “Most of the data are between 15 and 25.” Dividers and hat plots are TinkerPlots tools designed specifically to help students describe data in terms of these informal averages. Students can also use the Drawing tool to show where they think the bulk of the data are. It is fine for students to summarize groups and to describe differences by saying that one group’s center clump is higher up than another group’s. We expect that formal averages, like means and medians, will then eventually make more sense when students see that these are almost always located within what they see as the center clump.

Staying Grounded in the Data

Many researchers have reported the importance of students keeping in mind what a case is—that a data point on a graph is not simply a number or dot, but that it is a measurement for a case (for example, a person’s height). Often when students (or experts) get confused looking at a graph, it is because they lose this connection between a case and a point on the graph. In TinkerPlots, students can, at any time, click a point on a plot to see the data card for that individual case and to automatically highlight that case in any other plots that may be open. Again, this helps students keep in mind what a case is. It also helps them analyze their data, because when students highlight a case that has a high value for one attribute, they can see where that case is located in another graph of a different attribute. For these reasons, in all TinkerPlots graphs—even histograms, box plots, and pie graphs—it is easy for students to see cases and how those individual cases work together to form a particular graph. When one plot changes to another, TinkerPlots animates the transformation to help preserve the integrity of the case.
Using TinkerPlots in Different Classroom Settings

You can use TinkerPlots in a number of different ways with your students, ranging from having each student explore data individually to using one computer hooked to a projection device to analyze data as a whole class. However, whenever possible, encourage students to discuss among themselves the “story” of the data: what the data are, how they were collected, how particular attributes were probably measured, what questions they have about the data, and what they think they will find. After they’ve analyzed the data, allow time for students to share and discuss what they have found, encouraging them to use the graphs they’ve made to support their conclusions. Trying to convince each other, using the data, will help students develop critical thinking skills and show them the value of supporting claims with credible evidence.

In a computer lab. Copy the activity you want students to complete and hand each student a copy to take to the school’s computer lab and complete there. Alternatively, students can work in pairs on an assignment together. We’ve found it beneficial to have each student at a computer even when they are working cooperatively, so that each of them can easily take control of the program. It can be difficult to follow what another person does to make a graph, because things can happen quickly in TinkerPlots.

As a class. Hand out the activity to students and have them complete the Think About It section at home the night before or as part of a discussion with a partner or small group. Then as a class discuss the various answers students came up with. Sharing their expectations about what they will see makes it clear to students that different people expect different things. This diversity makes them all the more eager to see what the data actually say. Then work as a class to make a graph (or several graphs) that answer the question on a single computer hooked to a projection device. Again have different students make suggestions about what to do, and what the graphs mean.

Part of the reason some students don’t need much instruction in using TinkerPlots is that they are quite familiar with technology. Some even have more experience, and much less fear, than their teachers. And if allowed to collaborate and share with one another what they have just learned about the software with one another, students are remarkable. In a large computer lab, you won’t need to tell students to collaborate. Often they will do it naturally. One student will figure out how to do something new, and very quickly, that know-how will spread around the room. Some students will quickly become the local source of TinkerPlots know-how, and we’ve observed that these are often the very students who otherwise seem lost or uninterested in class. If there is something you want to introduce into your students’ repertoire, find a suitable time to show one or two students. Again, the know-how will spread.
Using the Activities

All of the activities in this book are designed for students from grades 4–8, unless otherwise noted in the Activity Notes. The difference between the grades will be in the depth of answers students can provide. The Activity Notes provide examples of what to expect from different levels of students on each question. Each activity is self-contained so that the activities can be done in any order, although some activities do build on each other, or share a topic.

The activities will work in many different classes. Mathematics classes can explore data analysis and graph making. Science classes can develop scientific inquiry skills and values. Students in social studies classes can look at real-world data and relate the data to what they’re learning about the world. Some activities are also appropriate for Health or Physical Education classes discussing the human body. The Activity Notes provide details on how different classes can use each activity.

The activities and Activity Notes are available in PDF format in the TinkerPlots | TinkerPlots Help folder.

Features of an Activity

Most of the activities are divided into three main sections: an introduction that provides context and motivation, a Think About It section where students use prior knowledge to speculate about the data, and a Plot and Investigate section, in which students work with the data to investigate the conjectures they’ve made and summarize their findings.

The amount of direction provided in the activities varies. Some activities lead students through making one type of graph, then let them loose on other topics. Other activities provide limited directions to students on how to use the software or even how to approach the problem that is posed. In all of the activities, figuring out what graph to make, and how to make it, is a key to making these activities engaging and a learning experience for students. The openness of the tasks requires students to think and helps strengthen their problem-solving and reasoning skills.

The questions in the activities range from short, fill-in-the-blank questions to those needing full paragraph responses. Spaces are provided on the activity worksheets, but in some cases students may need a separate sheet of paper. You might also have students type directly into their TinkerPlots document, and either print out the document or turn in the electronic file. In this case, make sure students know how to use the color key to lock the colors of their plots. Also make sure they don’t place text boxes on top of other objects, such as plots, because they will disappear behind the plot when the plot gets selected. All the data sets that come with TinkerPlots are locked, so students will need to save their file under a different name. To see a sample student report, open the file Backpack Report.tp, located in the Data and Demos | Demos folder.
Activity Notes

The Activity Notes are collected in the last chapter of the book. These provide detailed information on each activity, including time required, prerequisite knowledge, the mathematics of the activity, connections to other disciplines, general notes, and teaching tips. The Activity Notes also provide sample answers with variation by grade level, and extensions. You’ll find links that further explore the topic of the activity at the TinkerPlots Online Resource Center. You can also find many informative sites using your favorite Internet search engine. If you do find raw data on the Internet, you can import them into TinkerPlots by choosing Import from Url from the File menu. (See TinkerPlots Help for more information.)

Getting the Most from Written-Response Questions

It’s often hard for students to articulate their observations about data, especially in writing. Although some of the questions in these activities require simple answers, many ask for more detailed responses. These questions draw out students’ ideas and hypotheses, and their guesses about why certain things happen. They also encourage students to explain their observations and conclusions—in short, they aim at the same goals as the NCTM Standards of Communication and Reasoning. Pursuing these skills requires added time and attention, resources that we realize are at a premium in today’s classrooms. Students accustomed to traditional textbook exercises and the classroom culture of short, correct answers might be slow in coming to believe that you really want to see their thinking. These questions might also present difficulties for those students with weak written communication skills.

How can you as a teacher encourage your students to engage in thoughtful writing and discussion without forcing every student to spend the required time and energy on each written response? This will depend on the particulars of your own classroom and students, but you might find the following suggestions helpful.

1. Providing a why. Students might ask why they have to “write out all this stuff” when they already “know the answer.” Alternately, they might resist writing if they are unsure of the answer. In either case, you can encourage thoughtful writing by providing students with a good reason to do so.

Mathematicians, scientists, and historians communicate with each other to share their findings. Students’ plots are one way to communicate their findings, but written words direct the viewer’s attention to the relevant features of the graph. Mathematicians, scientists, and historians also communicate to provide clear, and sometimes even enlightening, explanations or arguments, and to convince each other of the truth and coherence of an argument.
Teaching with TinkerPlots (continued)

Students might be more inclined to write thoughtfully if they are trying to come up with an explanation that can help enlighten a fellow student, or one that most clearly or succinctly explains something. A fruitful discussion might even ensue if students do not all agree on which explanation is the “best.”

Mathematicians, scientists, and historians also write to help themselves think through a problem. For students who claim not to know where to start on a written response, it might help to ask them to write down what they don’t understand. Often by focusing first on what we don’t know, we begin to get some understanding of what we need to know but don’t.

2. Providing a model. Many students are uncomfortable with written responses because they do not know what is expected of them. One way to encourage thoughtful writing is to provide students with models of written responses. You might provide a question and written response that is a variation of the one you would like the students to answer, and ask them to imitate the model response. You might also provide a response to a question that has some obvious flaws in it. You can then ask students to critique the argument or to provide a better response. Either of these approaches will give students a better idea of what a good response looks like and some practice creating them.

3. Talking it through. Sometimes it helps to move from individual written responses to a larger group format where students can discuss questions verbally as a group or class. In these contexts, they can get ideas from one another and also see what kind of evidence or support students ask of one another to support an argument. One danger of larger group formats is that a few students might dominate the discussion. You can encourage wider participation by focusing not exclusively on the book’s questions, but also on relevant “meta-questions” such as: What was difficult about this question? Why did the book’s author think this question was important? What question do you think would have been a better one? Another problem is that students might not listen to one another during class discussion. You might try occasionally asking the class if everyone understood a particular student’s point, and then call on one student to summarize what another student has just said. This sends the message that it is their responsibility to listen and to try to understand one another. Again, you will need to model for students what a good summary is (“So Abigail is saying that . . . ”)

Using the Data Sets and Demonstrations

Once your students are familiar with TinkerPlots, you can have them explore any one of the data sets that come with the software (except the
demonstrations). These data sets usually have one or two suggested questions to help students get started. With these more open-ended activities, we recommend that you still encourage students to follow the basic set-up of the activities: Think about the question and what the data will show, then explore the data, and finally form a conclusion and use the graphs to support it. By the time students have answered the original question they will usually have generated many of their own and will want to find the answers to those by further exploring the data.

Make sure you review both the attributes and the types of numbers in any data set before you send students to work on it. Some data sets contain content that is more appropriate or interesting for older students—these data sets are marked with an * in the list on pages 5–7. Many data sets also contain decimal numbers, percents, or rates. With all of the data sets, it is critical that students understand what the data are before they try to analyze them or answer the questions. They should first read the information in the text box below the data cards, especially the Attribute Description. For some data sets, you may want to discuss each attribute with the class. Students need to understand what each attribute is and how to interpret its values before they begin.

Some of the demonstration files included with TinkerPlots can be used as classroom activities or demonstrations. (See pages 7–8 for details.) These are not intended to be handed directly to students; you will need to decide on the best format and use for your classroom, and edit the document accordingly. Some demonstrations also show ways you can create your own documents to teach concepts such as stable means and random sampling.

Making and Researching Your Own Data

At some point you’ll probably want students to find some different data to work with in TinkerPlots. One simple way to have students create their own data is to have them develop and administer a survey. There is also plenty of data available on the Internet. However, much of it will not be useful, for a variety of reasons. The links at the TinkerPlots Online Resource Center can give you a place to start. Here we give some advice on how to choose data sets for your students.

In looking for data, search for a topic students will be interested in and already know something about. These are by far the most important features for a good data set. When students know something about the situation from which the data come, they nearly always have expectations about what patterns and trends they will find in the data. For example, in the Backpacks.tp data set, students expect that students in higher grades carry more in their backpacks. They have some experience to base this on. Having expectations makes it easier for them to interpret the graph when they see it, even if the graph doesn’t agree with what they think.
Good data sets also contain a mix of numeric and category attributes. Category attributes (such as gender) make it easy for students to make groups in which they expect to see some difference for another attribute (such as height).

Be alert to the presence of decimal values in the data. If students do not know how to interpret decimals, displays of attributes using decimals will be hard for them to make sense of. You could use this as an occasion to explain decimals. Alternatively, you could round the data to whole number values before giving the data set to the students. (See the TinkerPlots Help to learn how to round data.)

You also want to make sure you use case-based data, sometimes called microdata. These are data that contain information about individual cases (individual cats, individual states, and so on). If you have only average numbers for an attribute (average weight for a group of cats, for instance), your data will still plot in TinkerPlots, but they won’t be very interesting. A lot of data on the Internet are not case-based. Government data about people are often made public only in aggregated form so that it is impossible to identify individuals. However, a great site for case-based data is the Data and Story Library, currently at http://lib.stat.cmu.edu/DASL/DataArchive.html.

The data set US States.tp is one set we made for teachers. It includes many attributes that teachers know something about but which students will not. These include average teacher salaries by state and percentage of voters who voted for George W. Bush in the 2000 presidential election. We tried using this data set in a class of 6th graders who had been studying the 50 states, and it flopped. The problem was that the attributes were not things they knew much, or cared, about. Also, many of the numeric attributes were rates (population density, for example) that included decimal values.

Sharing Data with Other Classes

You may come across some data your students find really fascinating, and want to share the data with other teachers. Or your students may make a great survey and then wonder how other students might answer their questions. At the TinkerPlots Online Resource Center, you can share data and activities with teachers from all around the world. Choose Online Resource Center from the Help menu, or go to www.keypress.com/tinkerplots.
Activities
Exploring Data with TinkerPlots

Many students develop back problems. Doctors believe that these problems are caused by the heavy backpacks students carry. Sometimes the way students carry their backpacks also hurts their backs.

In this activity you will look at data about students in grades 1, 3, 5, and 7 and decide which students carry the heaviest backpacks.

The data you’ll look at were collected by students. They went to one classroom in each grade at a school and had students weigh themselves and their backpacks.

At right is the data for Angie, a girl in first grade. The card shows that she weighs 45 pounds and her backpack weighs 4 pounds. (The “lb” you see in the Unit column is the abbreviation for pounds.)

Think About It

Before you look at data, think about what you expect to see. You probably already have some ideas about what these data look like.

**Q1** About how many pounds do you think a student’s backpack weighs, on average? (Include the weight of the backpack and everything in it.)

**Q2** Which students do you think usually carry heavier backpacks—students in higher grades (grades 5 and 7) or students in lower grades (grades 1 and 3)? Explain.

**Q3** Which students do you think usually carry heavier backpacks—girls or boys? Explain.
Plot and Investigate

Now you’ll look at the data to see what they say.

1. Open the document Heaviest Backpacks.tp. You should see a plot and a stack of data cards like the one on the previous page.

Q4 How many students do you have data for?

____________ students

2. First you’ll look at whether students in the higher grades tend to carry heavier backpacks than students in the lower grades. Make a graph that helps you answer this question. Include a copy of your graph with your assignment.

Q5 Which students usually carry heavier backpacks—students in higher grades or students in lower grades? Explain. Your answer should say how your graph backs up your conclusion.

3. Next you’ll look at whether girls or boys tend to carry heavier backpacks. Make a graph that helps you answer this question. Include a copy of your plot with your assignment.

Q6 Which students usually carry heavier backpacks—girls or boys? Explain. Your answer should say how your graph backs up your conclusion.
Is Your Backpack Too Heavy for You?

Many students develop back problems. Doctors believe that these problems are caused by the heavy backpacks students carry. Sometimes the way students carry their backpacks also hurts their backs.

If you did the activity Who Has the Heaviest Backpacks?, you looked at which students carry the heaviest backpacks. In this activity you’ll decide which students are carrying backpacks that are too heavy.

The data you’ll look at were collected by students. They went to one classroom in each grade at a school and had students weigh themselves and their backpacks.

At right is the data for Angie, a girl in first grade. The card shows that she weighs 45 pounds and her backpack weighs 4 pounds. (The “lb” you see in the Unit column is the abbreviation for pounds.)

Think About It

Before you look at data, think about what you expect to see. You probably already have some ideas about what these data look like.

Q1 About how heavy can a student’s backpack safely be? (If you can, discuss this with a partner.)

Q2 Do you think that some students can safely carry heavier backpacks than other students? Explain.
Is Your Backpack Too Heavy for You? (continued)

Q3 Doctors recommend that a student’s backpack should weigh no more than 15% of his or her body weight.

a. What is the heaviest safe backpack weight for a student who weighs 100 pounds?

_______ pounds

b. What is the heaviest safe backpack weight for a student who weighs 150 pounds?

_______ pounds

Plot and Investigate

Now you’ll look at the data to see what they say.

1. Open the document **Too Heavy Backpacks.tp**. You should see a plot and a stack of data cards like the one on the previous page. Look at the attribute on the bottom row of the data cards. This attribute is named *PercentWt*. It tells you what percentage a student’s backpack weight is of his or her body weight.

2. First you’ll look at which students carry backpacks that are too heavy. Make a graph that lets you quickly find these students. (*Hint: To make your graph and answer the next question, you might use reference lines, dividers, or the percent button. These features are on the upper plot toolbar.*)

Q4 About what percentage of the students carry backpacks that are too heavy (more than 15% of their body weight)?

Students in the higher grades (grades 5 and 7) carry heavier backpacks than students in the lower grades. But students in higher grades also tend to weigh more than students in lower grades. What do you find if you look at percent weight? Find out if students in the higher grades carry heavier backpacks for their body weight than students in the lower grades.

3. Make a graph that helps you see whether students in the higher grades carry heavier backpacks for their body weight than students in lower grades. Include a copy of your graph with your assignment.
Is Your Backpack Too Heavy for You? (continued)

Q5 What percentage of students in the higher grades (grades 5 and 7) carry backpacks that are too heavy (more than 15% of their body weight)?

Q6 What percentage of students in the lower grades (grades 1 and 3) carry backpacks that are too heavy?

Q7 Which students tend to carry backpacks that weigh more for their body weight—students in higher grades or students in lower grades? Explain. Your answer should say how your graph backs up your conclusion. Also include any other conclusions you can make from your graph and explain how your graph supports them.
Factors

In this activity you will explore patterns related to multiplication. You’ll look at properties of the numbers 1 to 100. At right are the data for the number 24. Notice that the value for factor3 is “yes.” This means that 3 is a factor of 24. You can see that 2, 3, 4, 6, 8, and 12 are all factors of 24.

Plot and Investigate

Now you’ll look at the data to see what patterns you can find.

1. Open the document Factors.tp. You’ll see a stack of data cards like the one at right.

2. You’ll also see a plot of square icons stacked and ordered by number. Drag the right and bottom edges of the plot. You’ll see the square icons move around to form stacks of different sizes.

3. Drag the edges or corner of the plot so that the stack is 3 wide, as shown here. You can also use the Icon Size slider to make the squares fit better.

Q1 Describe any patterns you notice in this stack.

4. Now select the attribute factor3 in the data cards. The color of the plot should change. (The key above the plot tells you what the colors mean.)

Q2 Describe any patterns you notice in the stack now.
Factors (continued)

Q3  What do you think will happen if you make the stack 5 wide and select the attribute \textit{factor}5? Write your prediction, and then try it.

Q4  In general, what will happen if you make a stack of a particular width and select the same factor as the width? Why does this happen? Include a copy of at least one graph that backs up your answer.

You probably know that division is the inverse (or opposite) of multiplication. You can use your plot to explore division too.

5.  Think about the division problem 24 ÷ 8. You probably already know the answer is 3. This means that there are 3 groups of 8 in 24 (or 8 groups of 3 in 24). Because you are dividing by 8, make a stack 8 wide and select \textit{factor}8. Look for 24 in the stack.

Q5  What does the color of the icon for 24 tell you?

Q6  How high is 24 in the stack? How does this relate to 24 ÷ 8?
Factors (continued)

6. Think about the division problem $24 \div 8$ again. Because you are dividing 24, make the stack 24 wide but keep factor 8 selected. Look for 24.

Q7 How does this plot show you that $24 \div 8 = 3$?

Q8 Use either method of making a plot to do these division problems. For at least one problem, include a copy of your plot and explain how it gives you the answer.

a. $18 \div 3 = $  
b. $26 \div 13 = $

c. $11 \div 2 = $  
d. $8 \div 3 = $

7. As you change the size of the stack, you probably see the factors create different patterns in the stack. Experiment with different sizes and different factors to find one pattern that is interesting to you. Include a copy of this plot with your assignment.

Q9 Describe why this pattern is interesting to you. If you can, explain how the width and factor combine to create the pattern.
Number Properties

In this activity you will explore the whole numbers 1 to 100. You’ll look at three types of whole numbers.

Square numbers are produced by multiplying a number by itself, such as $4 \times 4 = 16$. You say that 16 is a perfect square. You can represent a perfect square number by arranging objects in the shape of a square. At right is a square made up of 16 smaller squares, showing that 16 is a perfect square.

Triangular numbers can be represented by objects arranged in the shape of an equilateral triangle. Here are triangles that represent the first four triangular numbers. What are the numbers?

Prime numbers have only two factors—1 and the number itself. For example, 5 is a prime number because its only factors are 1 and 5.

At right are the data for the number 36. The “yes” and “no” values for the attributes show that 36 is a perfect square and a triangular number, but it is not prime.

Plot and Investigate

Now you’ll look at the data to see what patterns you can find. Let’s start with the perfect squares.

1. Open the document Number Properties.tp. You’ll see a stack of data cards like the one above.

2. You’ll also see a plot of square icons ordered by number. Drag the bottom edge, right edge, or bottom-right corner to make a stack that is 4 wide, as shown at right. You can also use the Icon Size slider to make the squares fit better, but don’t make them too small.

3. Select the attribute perfect_square in the data cards. The color of the plot will change, as shown at right. Include a copy of this plot with your assignment.
Q1  Do you see a pattern to the square numbers in the plot? Describe the pattern as fully as you can.

Q2  Assume that you have data for numbers greater than 100. Based on the pattern that you see, where will the next five perfect squares appear? If you can, figure out the value of those square numbers.

4. Drag the edges or corner of the plot to change the size of the stack. Find another stack that helps you see a pattern to the square numbers. Include a copy of this plot with your assignment.

Q3  Fully describe the pattern that you see in this stack. Explain how this pattern compares with the pattern that you saw in Q1.

Now you’ll look at the triangular numbers.

5. Select the attribute triangular in the data cards. Change your plot or make a new plot that shows a pattern to the triangular numbers. Feel free to experiment with different options. For example, you don’t have to use square icons. Include a copy of your plot with your assignment.

Q4  Describe the pattern that you see in the triangular numbers as completely as you can. Based on your pattern, what are the next five triangular numbers greater than 100?
Now you’ll explore the prime numbers.

6. Select the attribute *prime* in the data cards.

7. Make at least one plot that shows possible patterns for the prime numbers. Include a copy of your plot(s) with your assignment.

**Q5** Describe any possible patterns that you see in the prime numbers. Your answer should say how your plots help you see these patterns. Can you use the patterns to predict the next five prime numbers greater than 100?
Men’s 100-Meter Dash at the Olympics

The first Olympic Games of modern times were held in Athens, Greece, in 1896. They have been held every four years since, with three exceptions. They were not held in 1916, 1940, or 1944 because of World Wars I and II.

In this activity you’ll explore the winning times for the men’s 100-meter dash from all the Olympics from 1896 to 2000. You’ll also look at how these times have changed over the years.

Here is a data card from the 1968 Olympics, which were held in Mexico City. The names of the attributes are in the left column. Most of them are track-and-field events. The names of women’s events begin with a W, and the men’s events begin with an M. So the attribute **M_100Meters** is the men’s gold-medal time for running the 100-meter dash. From the data card you can see that the gold-medal time for the 100-meter dash in the 1968 Olympics was 9.95 seconds. The **Unit** column shows the units of time or distance for the event.

### Think About It

Before you look at data, think about what you expect to see. You probably already have some ideas about what these data look like.

**Q1** Today, how many seconds do you think it would take the fastest man to run 100 meters? (100 meters is about 109 yards, which is about the length of a football field.)

**Q2** Do you think this time is different from times 50 or 100 years ago? Longer or shorter? Why?
Men’s 100-Meter Dash at the Olympics (continued)

Plot and Investigate
Now you’ll look at the data to see what they say.

1. Open the document **Olympics 100 Meter.tp**. You should see a stack of data cards like the one on the previous page.

First you’ll make a graph to see the gold-medal times of the men’s 100-meter dash for all the Olympics.

2. In the data cards, click the **Year** attribute to select it.

3. Click a case icon in the plot and drag it to the right until the **Year** attribute is fully separated—until there are no bin lines and the axis is a continuous number line.

4. In the data cards, select the attribute **M_100Meters**.

5. Click one of the case icons in the plot and drag it all the way up, until **M_100Meters** is fully separated.

6. From the **Plot** menu, choose **Show Connecting Lines**.

Your graph should look something like the one below. This kind of graph is often called a **time series graph** because it shows how something has changed over time.

Q3 Between which years was there the greatest change in the gold-medal time of the men’s 100-meter dash?

Q4 Describe what the time series graph tells you about the winning times over the years in the men’s 100-meter dash.
Men’s 100-Meter Dash at the Olympics (continued)

Q5  Based on the data, what do you think will be the gold-medal time in the men’s 100-meter dash for the next Olympics?

Q6  Describe how you came up with your answer to Q5.

Q7  Does the time series graph suggest to you that men are getting closer to a winning time that will never get shorter? Explain.
Men and Women at the Olympics  Name(s): __________________

The first Olympic Games of modern times were held in Athens, Greece, in 1896. They have been held every four years since, with three exceptions. They were not held in 1916, 1940, or 1944 because of World Wars I and II.

In this activity you’ll explore the winning times and distances from all the Olympics in certain events. For these events, we have the time (or distance) of the gold-medal winner in each Olympics. You’ll compare the men’s results with the women’s results.

Here is a data card from the 1948 Olympics, which were held in London. The names of the attributes are in the left column. The “w” in the gender row means that this card shows the women’s gold-medal results for each event. The times for the 100Meters and 200Meters races are in seconds. The distances for the HighJump and LongJump are in meters. A meter is a little bit longer than a yard.

Think About It

Before you look at data, think about what you expect to see. You probably already have some ideas about what these data look like.

Q1 How do you think the women’s gold-medal times in the 100-meter dash will compare with the men’s gold-medal times? If you think one gender’s times will be better than the other’s, about how much better will they be?

Q2 Suppose there is a difference in the gold-medal times for men and for women. Do you think that over the years the difference is getting bigger, getting smaller, or staying the same?
Men and Women at the Olympics (continued)

Plot and Investigate

Now you’ll look at the data to see what they say.

1. Open the document Olympics Men Women.tp. You should see a stack of data cards like the one on the previous page.

2. You made a guess about how the gold-medal times in the 100-meter dash compare for men and women. Make a graph that you can use to answer this question. Include a copy of your graph with your assignment.

Q3 Are one gender’s gold-medal times better than the other’s in the 100-meter dash? Explain. Your answer should say how your graph backs up your conclusion.

Q4 If you think the results show that one gender tends to have better times than the other, about how many seconds better is the faster gender?

Q5 Explain how you came up with your answer to Q4.

Q6 Choose another event in which both men and women compete. Compare their gold-medal times (or distances). Include a copy of the graph you make, and explain what you think the graph shows.
The Yo-Yo Mystery

Name(s): ______________________

Last night, the Yo-Yo Factory was broken into and robbed. Detectives investigating the break-in think that it was an “inside job.” Their prime suspect has been working at the Yo-Yo Factory for six months.

The police want you to look at some data that could help solve the mystery. Before you look at the data, you need to know some of the facts of the case.

Information from the Police Report

The Yo-Yo Factory makes yo-yos. The plastic bodies of their yo-yos are made by a machine that can make about 147,600 yo-yo bodies each day. The machine runs 24 hours a day.

Yesterday evening, the last person to leave the Yo-Yo Factory was the manager. He left at 8:00 P.M. He was also the first person to arrive in the morning, at 6:00 A.M. When he got there, he discovered the front door had been forced open. He also found that the company’s safe had been broken into. About $4,500 was missing.

Every two minutes, the yo-yo machine automatically records the number of yo-yo bodies it has made during the last two minutes. The number of yo-yos it makes every two minutes varies, but on average it makes about 210 yo-yos.

The front door was forced open during last night’s break-in. When that happened, all the power went off just for a moment, and then it came back on. When the power goes out, even for a moment, the yo-yo machine slows down a little. It then keeps working at this slower speed until someone who knows how readjusts it. This means that for the rest of the night after the break-in, the machine was running at this slower speed, making fewer yo-yos on average than it normally does.

The police hope that by looking at the data from the yo-yo machine, you will be able to tell them when the break-in happened. What they most want to know is whether the break-in happened before 12:00 A.M. or after 3:00 A.M., because these are times when their suspect has no alibi.

The suspect told police that last night he went home right after work at 5:30 P.M., ate, and then slept for a while. He lives alone, so no one can back up his story. He was at a club with friends from 12:00 A.M. to 3:00 A.M. People at the club saw him there during those times. He says he was home alone sleeping from 3:30 A.M. to 7:00 A.M.
The police made this chart to show what they know so far:

<table>
<thead>
<tr>
<th>Time</th>
<th>Event at Factory</th>
<th>Suspect’s Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:00 P.M.</td>
<td>Manager last to leave</td>
<td></td>
</tr>
<tr>
<td>9:00 P.M.</td>
<td></td>
<td>?</td>
</tr>
<tr>
<td>10:00 P.M.</td>
<td></td>
<td>?</td>
</tr>
<tr>
<td>11:00 P.M.</td>
<td></td>
<td>?</td>
</tr>
<tr>
<td>12:00 A.M.</td>
<td>Arrives at club</td>
<td></td>
</tr>
<tr>
<td>1:00 A.M.</td>
<td>At club</td>
<td></td>
</tr>
<tr>
<td>2:00 A.M.</td>
<td>At club</td>
<td></td>
</tr>
<tr>
<td>3:00 A.M.</td>
<td>Leaves club</td>
<td></td>
</tr>
<tr>
<td>4:00 A.M.</td>
<td></td>
<td>?</td>
</tr>
<tr>
<td>5:00 A.M.</td>
<td></td>
<td>?</td>
</tr>
<tr>
<td>6:00 A.M.</td>
<td>Manager discovers break-in</td>
<td>?</td>
</tr>
</tbody>
</table>

**Plot and Investigate**

Now you’ll look at the data to see what they say.

1. Open the document *Yo-Yo Mystery.tp*. You’ll see a stack of data cards like the one at right. The attribute names are described below the data cards. Read the descriptions so that you know what the attribute names mean. If you’re uncertain, make a few simple graphs of the attributes to figure them out.

**Q1** The data card at right shows the data for case 274.

a. Explain what the value of 201 for *Number_YoYo* means.

b. Explain what the value of “five” for *Hour* means.

c. Explain what the value of 548 for *ElapsedTime* means.
The Yo-Yo Mystery (continued)

2. Make a graph that helps you decide when the break-in probably happened. Include a copy of your graph with your assignment.

Q2 Looking at the data, about when do you think the break-in happened? Explain how your graph backs up your conclusion.

Q3 Based on your graph, could the suspect have committed the break-in? Explain.
Who Has the Heaviest Backpacks?
(page 21)

Activity Time: 30–55 minutes

Required Document: Heaviest Backpacks.tp from the folder Data and Demos | Exploring Data Starters. This document uses the same data as Too Heavy Backpacks.tp in the same folder and Backpacks.tp in the folder Data and Demos | Health. However, in this document the PercentWt attribute has been deleted as it is not used in this activity.

Sample Document: Backpack Report.tp in the folder Data and Demos | Demos shows a possible student report for this activity and the activity Is Your Backpack Too Heavy for You?

Prerequisites: Students need to know that TinkerPlots collects data in data cards and that plots allow you to display and organize data. These are introduced in the movie TinkerPlots Basics, which students should see first.

Mathematics: Students will compare related sets of data; make observations about differences between groups; distinguish between categorical and numerical data; describe the shape and other important aspects of numerical data; justify conclusions based on data; and represent data with graphs.

Connections: This activity could also be used for, or in connection with, science classes, health classes, or physical education classes. Science instructors can use the activity as a way to engage students in the phases of scientific inquiry (ask a question, design an investigation, gather and analyze data, and formulate an answer) and as a tool for understanding the relationship between explanation and evidence. Science, health, and physical education instructors can use the activity to discuss the growth and development of human beings, the systems of the human body that might be affected by carrying backpacks (for example, muscles and bones), and issues of personal health and safety, both immediate and long-term effects.

General Notes: The main focus of this activity is comparing groups—comparing backpack weights for students in different grades and comparing backpack weights for boys and girls. The level of sophistication that students use for these comparisons will vary by grade level, but all comparisons should include some descriptions and use of centers, such as means or center clumps (see page 11 for more information). Later grades may also focus on differences in spread among the groups.

The activity Is Your Backpack Too Heavy for You? extends the themes of this activity and could be used in conjunction with it.

For grades 4–5, this activity also provides a good opportunity to distinguish between categorical and numerical data. Students should be able to identify the categorical attributes (Name, Gender, Grade) from the numerical attributes (BodyWeight, PackWeight). If you use this activity to introduce TinkerPlots, you can have students explore how TinkerPlots uses color for different types of attributes and what happens when you separate categorical versus numerical attributes.

For all grades, students should explore different ways of separating, ordering, and stacking the data, creating a variety of graphical representations. They should observe how different plots highlight different aspects of the data and choose a plot that helps them tell the story they want to tell.

Think About It

Encourage students to work in pairs or small groups to write answers for the Think About It questions, or have students write individual answers and then discuss them in groups. Involving students in group discussions will foster communication, help make apparent common expectations about the data and questions, and illuminate alternative ideas.

Q1 Answers will vary depending on grade level and estimation skills. Many students will want to give a range for an answer (for example, “5 to 10 pounds”), and this is perfectly acceptable; there is no reason to force students into giving a single number. As guideposts for answers, the data in Heaviest Backpacks.tp have a mean of 10.2 pounds and a median of 8 pounds. The middle 50% of the values range from about 5 to 14 pounds.

Students may have trouble estimating weights in pounds, so you may want to have some reference weights available, such as 3-, 5-, and 10-pound weights from your gymnasium or 5- and 10-pound bags of sugar.

Note: This question uses the figure of speech “on average.” Although students in grades 6–8 may immediately think “mathematical average,” the question is not necessarily asking for the mean. Encourage students to think about what backpack weight or weights are “typical.” Students are likely to use their own backpacks
as a way to estimate; if so, be sure to have them adjust their estimates to include the whole group in question, which includes first-, third-, fifth-, and seventh-grade students.

Q2 Students will likely guess that students in higher grades carry heavier backpacks. Explanations may include heavier books in higher grades, more books or homework in higher grades, or additional items such as sports equipment.

Q3 Some students might guess that girls carry heavier backpacks because they are (stereotypically) more studious; some might guess that boys carry heavier backpacks because they (stereotypically) want to show how strong they are, or carry extra items such as sports equipment; and some might think the weights are the same because both boys and girls are in the same classes and have the same books.

Plot and Investigate

Q4 79 students. Students can find this answer from the upper-right corner of the data cards, by counting the circles in the plot, or by adding counts to the plot.

Q5 Yes, students in higher grades tend to carry heavier backpacks than students in lower grades. Explanations must include how the plot supports their answers.

Students in grades 4–5 should, at the least, use a plot that is ordered by PackWeight and colored by Grade. Students’ explanations should then note that first-graders (light-pink) tend to be on the far left (lower weights); third-graders (pink) tend to be in the middle left; fifth-graders (red) tend to be in the middle right; and seventh-graders (dark red) tend to be on the far right (higher weights).

Students may separate the case icons into bins, as shown at the top of the next column. Many students will want to compare the counts in common bins: “There are more students that carry backpacks above 16 pounds in grade 7 than in any other grade. So students in grade 7 carry heavier backpacks.” However, because the data do not include the same total number of students in each grade, this is not a valid argument. Students should instead think in terms of fractions or percents (“68% of students in grade 7 carry backpacks over 15 pounds, but only 18% of students in grade 5 and 0% in grades 1 and 3 carry backpacks over 15 pounds. So students in grade 7 carry heavier backpacks”). Alternatively, students could focus on center clumps (“Grade 1 cluster around 1–5 pounds. Grade 3 cluster around 6–10 pounds. Grade 5 cluster around 6–15 pounds. And grade 7 cluster around 16–25 pounds.”)

Some students, especially those in grades 6–8, will fully separate both Grade and PackWeight. They might use various ways to highlight and argue why the data show students in higher grades tend to carry heavier backpacks. The plot below uses dividers to highlight center clusters. Here, the clusters in the gray divisions show an increase as the grades increase.

Depending on their proficiency with TinkerPlots, in grades 4–5 might include range hats, the mode, or the median to further support their answer. Students in grades 6–8 might use box plots or the mean.

Commend students who try other plots that clearly support their conclusions, including students who are able to construct plots that support alternative conclusions. Encourage older students to refine their conclusions by using precise statements, such as “50% of seventh-graders have a backpack between 12 and 21 pounds.”
Q6 Answers will vary depending on the plots and statistics used. Again, students must explain how the plot supports their answers.

A simple plot ordered by PackWeight and colored by Gender may show no noticeable difference between boys and girls. Even a more sophisticated plot, such as a stacked dot plot (see below), may show little or no difference. Students might explain that these plots show about the same number of boys and girls with heavy and light backpacks, or that the clusters are located in about the same places.

If older or advanced students use hat plots, the median, or the mean, they may notice that boys carry slightly heavier backpacks than girls. For the plot below, a student might say, “The median for boys is 8.5 and the median for girls is 7, so boys carry heavier backpacks.” Even so, some students may feel that the difference is not significant enough and still say that boys and girls tend to carry about the same amount of weight in their backpacks. (In fact, this is what a statistician would likely say as well.)

Note: So that students are able to create two plots in their document—one for Q5 and one for Q6, you may need to show them how to use the lock icon Key to lock the plot color (as shown in all of the plots above).

Extensions

1. Have students conduct their own study, collect data about backpacks at your school, and analyze the results. Compare the results from your school with the results for the data in Heaviest Backpacks.tp. You may want to do this along with a talk about samples and populations, discussing whether students think data from any one school are likely to be representative of schools across the country. Students could even plan ways to collect more representative data (for example, by collecting data at several different schools or by gathering statewide or nationwide data via the Internet).

2. Hold a discussion about ways students could lighten their backpacks or about the proper way to carry a backpack to minimize stress. See the links in the TinkerPlots Online Resource Center for more information. If students conduct their own study, they may want to collect additional data about the way each student carries his or her backpack and whether each student has experienced back pain.

3. Discuss outliers. For grades 4–5, ask students what they think an outlier is, and then have them identify data values that might be outliers. (Faith, the seventh-grader with the 39-pound backpack, is an obvious outlier.) Rather than focusing too much on the specific definition of an outlier, encourage students to consider whether the outliers’ values are correct or not. Sometimes values that are extremely far away are errors, while other times they are actual values and thus of particular interest. More typically, as is the case here, there is no way to tell for certain.

Students in grades 6–8 who used the mean or median to summarize the data could delete the outliers from the collection or change their values and see how this affects the average.

4. Ask questions that challenge students to predict cases that were not sampled. For example, “Judy is a seventh-grader. She was absent on the day these data were collected. If you had to guess the weight of her backpack, what would you guess?” You can also have students make predictions for whole groups: “Suppose we measure the backpack weights of second-graders at the same school. What would the average weight be? Make up a reasonable collection of 20 cases for the second-graders.” Students can add these cases to the data set.

Links

You and your students can find links to additional data and information about backpack weight and safety at the TinkerPlots Online Resource Center. Choose Online Resource Center from the Help menu or go to www.keypress.com/tinkerplots.
Is Your Backpack Too Heavy for You? (page 23)

**Activity Time:** 45–55 minutes

**Required Document:** Too Heavy Backpacks.tp from the folder Data and Demos | Exploring Data Starters. This document uses the same data as Backpacks.tp in the folder Data and Demos | Health.

**Sample Document:** Backpack Report.tp in the folder Data and Demos | Demos shows a possible student report for this activity and the activity Who Has the Heaviest Backpacks?

**Prerequisites:** Students need to know the word *percentage*, understand the mathematical concept of *percents*, and be able to calculate them.

Students should know the basics about TinkerPlots *data cards* and *plots*. During this activity, students will probably want to use *reference lines*, *dividers*, or *percents*, so you’ll need to have previously introduced these buttons or you’ll need to make plans to introduce them during the course of this activity.

**Mathematics:** Students will calculate, compare, and order percents; compare related sets of data; make observations about differences between groups; describe important features of a set of data; justify conclusions based on data; and represent data with graphs.

**Connections:** This activity could also be used for, or in connection with, science classes, health classes, or physical education classes. Science instructors can use the activity as a way to engage students in the phases of scientific inquiry (ask a question, design an investigation, gather and analyze data, and formulate an answer) and as a tool for understanding the relationship between explanation and evidence. Science, health, and physical education instructors can use the activity to discuss the growth and development of human beings, the systems of the human body that might be affected by carrying backpacks (for example, muscles and bones), and issues of personal health and safety, both immediate and long-term effects. Science and health instructors might also want to talk about the formal research that would have been involved in prescribing “15% of body weight” as the maximum safe weight for backpacks. Physical education instructors might discuss the distinction between the *most* that someone can lift and the safest amount that someone can *repeatedly* lift.

**General Notes:** The main focus of this activity is identifying and describing important features of a set of data, specifically identifying which data values meet or surpass a given standard. Although the idea is not complex, the execution will require students to create multiple plots in TinkerPlots and add reference lines or dividers. Hence, the activity may require an extended amount of time.

It is helpful, although not mandatory, for students to have already done Who Has the Heaviest Backpacks? Using that activity first gives students prior experience with the backpack data and illuminates some relevant patterns (i.e., that students in the higher grades tend to carry heavier backpacks than students in the lower grades).

This activity relies heavily on the concept of percent, which may make it more challenging than Who Has the Heaviest Backpacks?, especially for students in grades 4–5. On one level, students need to understand that the attribute *PercentWt* represents each student’s backpack weight relative to his or her body weight. On another level, students need to be able to identify the percent of *PercentWt* values that exceed a given standard.

If you prefer, you could delete the attribute *PercentWt* before distributing the document and require students to create their own attribute for *PercentWt* using a formula that will calculate the appropriate percent. This gives students deeper experience using TinkerPlots and further develops their conceptual understanding of percents. (*Note:* You’ll want to similarly modify step 1 under Plot and Investigate on the student worksheet.) The easiest way to delete the attribute is to select it in the data cards and choose *Delete Attribute* from the *Edit* menu. Students can add a new attribute by double-clicking <new attribute> and naming the attribute; they define the formula by double-clicking the *Formula* cell for the new attribute or highlighting the attribute and choosing *Edit Formula* from the *Edit* menu.

*Note:* The attribute *PercentWt* is rounded to the nearest percent. If you have students define their own attribute with a formula, you may want to have them similarly use the *round* function.

The opening questions, Q1 to Q3, often ignite a lively class discussion. Students may see this as an opportunity to argue for less schoolwork. If you have enough time, you may want to hold a class discussion about this, including ways that backpacks could be lightened without actually
reducing the amount of schoolwork. Students could do additional research on legislation that formally limits the weight of backpacks and methods that some schools are taking, such as electronic textbooks and online assignments.

**Think About It**

Encourage students to work in pairs or small groups to write answers for the Think About It questions, or have students write individual answers and then discuss them in groups. Involving students in group discussions will foster communication, help make apparent common expectations about the data and questions, and illuminate alternative ideas.

**Q1** Answers will vary.

**Q2** Students will probably recognize that many factors influence how much someone can safely carry. They may mention factors such as age, height, weight, gender, physical development or disability, and overall strength.

After answering this question, and possibly having a class discussion, you may want to suggest that students revisit **Q1**. After considering the factors that influence one’s ability to carry a heavy backpack, some students may realize that their answers to **Q1** were unnecessarily absolute (“10 pounds is a safe weight for a backpack”). They may now want to further qualify their answer (“10 to 15 pounds is a safe weight for a backpack for seventh-graders with average physical development”).

**Q3**

a. 15 pounds  
b. 22.5 pounds

**Plot and Investigate**

**Q4** 38% of students are carrying backpacks that are more than 15% of their body weight. (Note: Depending on the plot used and whether PercentWt is rounded, student answers could vary between 37% and 41%.)

Students could create a variety of plots that answer this question. The simple plot below orders and labels the cases by PercentWt. Students could then count the icons with values greater than 15 to find 30 cases above 15%. Students could then manually calculate that this is about 40.5%.

**Q5** 50% of students in grade 5 are carrying too much, and 74% of students in grade 7 are carrying too much. Collectively, 61% of students in the higher grades (grades 5 and 7) are...
carrying too much. Either answer should be considered correct.

Any of the plots used for Q4 can be embellished by adding Grade to the other axis. Students can then find the counts or percentages of students carrying too much for each grade. For example, here’s the fully separated dot plot with Grade added:

Some students may interpret the question to mean grades 5 and 7, collectively. Using the plot above, students could pull a case from the seventh-grade group towards the fifth-graders, which will make a new combined group called “other.” Alternatively, students could filter out the first- and third-graders by selecting the first- and third-graders (by drawing a selection marquee around them) and then choosing Hide Selected Cases from the Plot menu.

If some students do find the individual percentages while others find the collective percentage, you can have a class discussion about why the average of 50% and 74% is not 61%. (Because there is a different total number of students in each grade.)

Q6 12% of students in grade 1 are carrying too much, and 14% of students in grade 3 are carrying too much. Collectively, 13% of students in the lower grades (one and three) are carrying too much. Either answer should be considered correct.

Q7 Yes, students in higher grades tend to carry backpacks that weigh a higher percentage of their body weight than students in lower grades. Explanations must include how the plot supports their answers.

Most students will probably use the plots and percentages that they found for Q5 and Q6—that as the grade increases, the percentage of students carrying backpacks above 15% of their body weight increases from 12% to 14% to 50% to 74%.

Students in grades 6–8 might also use the median or mean to show how the average percentage of body weight increases by grade. For example, the means increase from 10.3% to 11.3% to 15.1% to 18.5%.

Extensions

1. Have students conduct their own study, collect data about backpacks at your school, and analyze the results. Compare the results from your school with the results for the data in Too Heavy Backpacks.tp. You may want to do this along with a talk about samples and populations, discussing whether students think data from any one school are likely to be representative of schools across the country. Students could even plan ways to collect more representative data (for example, by collecting data at several different schools or by gathering statewide or nationwide data via the Internet).

2. Hold a discussion about things that students could do to lighten their backpacks or about the proper way to carry a backpack to minimize stress. See the links in the TinkerPlots Online Resource Center for more information. If students conduct their own study, they may want to collect additional data about the way each student carries his or her backpack and whether each student has experienced back pain.

3. Have students revisit Q1 and, in light of the data, state specific cutoff weights for the backpacks of students in each grade. For example, students might find that the mean body weight of a seventh-grader is 94 pounds, so 15% of that, or 14 pounds, is the maximum safe weight for a seventh-grader’s backpack. (Some students might argue for using the
minimum or maximum body weight or for using a range of values rather than one absolute value.) You might extend this into a discussion about how teachers, parents, and school board members might use this information when adopting textbooks or shaping school policy.

4. This activity focused on differences between grade levels. Ask students to continue analyzing the data to find differences between genders or body weights. Body weight is particularly interesting because students can debate to what degree body weight depends on grade level. (This raises the distinction between correlation and causation. Does gaining body weight cause students to carry heavier backpacks? Probably not. Rather, as students get older, their body weight increases, they move into higher grades, and they have more homework.)

For students in grades 6–8, you can even begin to look at bivariate relationships between attributes. For example, what does a scatter plot of BodyWeight and PackWeight tell you? (As body weight increases, the backpack weight tends to increase, but there are plenty of exceptions.) If students are novices with scatter plots, other types of plots, such as binned scatter plots, may be an easier way for them to recognize the relationship between the two attributes.

**Links**

You and your students can find links to additional data and information about backpack weight and safety at the TinkerPlots Online Resource Center. Choose Online Resource Center from the Help menu or go to www.keypress.com/tinkerplots.

**Factors (page 26)**

**Activity Time:** 30–55 minutes

**Required Document:** Factors.tp from the folder Data and Demos | Exploring Data Starters. This document uses the same data as Number Properties.tp in this folder and Numbers.tp in the folder Data and Demos | Science and Nature. In each document the attributes are ordered by their use in the activity.

**Prerequisites:** Students need to know basic multiplication and division of whole numbers. Preferably, students are familiar with the mathematical term factor.

**Mathematics:** Students will recognize different representations for the same number; select, apply, and translate among mathematical representations; describe numbers in terms of their factors; understand various meanings of multiplication and division; and understand the inverse relationship between multiplication and division.

**Connections:** This activity is primarily mathematical. However, students will enjoy the patterns that result from changing the width of the plot and coloring by different factors. This can lead them to general observations that they need not formalize. For example, to get perfectly diagonal patterns, you make the stack one wider or narrower than the factor.

**General Notes:** This activity explores the connection between multiplication and division, and between factors and multiples. Students use roughly rectangular stacks of the numbers 1 to 100 and color every multiple of a specific factor. The patterns created by the colored numbers help them identify every multiple of the factor.

The primary goal of this activity is for students to explore how they can describe whole numbers in terms of their factors. Most middle-school students have probably had experience representing multiplication with a rectangular arrangement of blocks. This activity takes advantage of that familiarity and builds on it by allowing students to quickly change the height and width of the rectangle to see what products result.

The student worksheet is relatively straightforward, giving step-by-step instructions for creating a few plots and asking specific questions about those plots. For students in grades 6–8, you may want to break away from the worksheet and encourage students to do independent explorations of the factor patterns. Students will find them compelling and can locate
and describe many patterns. The extensions at the end of these activity notes offer suggestions for going even further into algebraic concepts and primes.

A secondary goal is to show how you can use TinkerPlots to explore non-statistical concepts and data. This activity in particular uses data about the characteristics of numbers to develop number sense and explore multiple representations.

Plot and Investigate

Q1 Answers will vary depending on grade level. If students have left the icons colored by number, they may notice only that the color gets darker as the numbers increase.

Older students may notice patterns as they go up the columns, such as “3 is added each time I go up.” They may also notice that the third column represents the multiples of 3.

Q2 Students should identify the third column as “multiples of 3.” Some students may appropriately use the terminology defined at the beginning of the worksheet and say that these are the numbers with “3 as a factor.”

Predictions will vary. An ideal answer is to guess that a stack 5 wide and colored by factor5 will have all the multiples of 5, or the numbers with 5 as a factor, in the last column.

Although this question may seem obvious to you, and to many students, it is a necessary building block for some students. The goal of this question is to allow students who don’t see the connection between factors and multiples an opportunity to use inductive reasoning—to recognize a pattern and make a generalization.

Allowing time to explore the pattern will strengthen students’ reasoning skills and help them make the connection between factors and multiples. In fact, you may prefer to have students repeat Q3 for a few other width-factor combinations before moving on to Q4.

Q4 In general, a stack X wide and colored by factorX will have all multiples of X, or all numbers with X as a factor, in the last column.

Note: Obviously, many students will not be able to state this in these general terms, but they may be able to give several numeric examples.

After trying several width-factor combinations, students should be able to explain why this happens: “The numbers with 5 as a factor are all multiples of 5. So, if the stack is 5 wide, all the multiples of 5 will be on the end of the rows.”

Q5 The icon for 24 will be colored like all of the numbers with 8 as a factor. This means that 8 is a factor of 24, and 8 divides into 24 with no remainder.

Q6 The icon for 24 is in the 3rd row of the stack. The 3rd row is related to the answer 3.

You may want to pause here and help students see the connection to familiar rectangular diagrams for multiplication. If you look at the rectangle that is defined by 24, it is 8 wide and 3 high, or \(8 \times 3 = 24\). It is because of the inverse relationship between multiplication and division that we are able to use this rectangular model to solve \(24 \div 8 = 3\).

Q7 This plot shows that there are 3 complete groups of 8 in 24 and this another way of explaining why \(24 \div 8 = 3\).

This solution represents division by what may be another familiar process—making equal groups. However, because the row of icons is continuous, some students may have trouble recognizing it as groups.

If you like, you can point out one way to translate between the representations in Q6 and Q7: take the rectangle in Q6; imagine cutting the rows into 3 separate rows; and then put the rows end to end.

Q8 Students can use either method for these division problems. The answers below show alternating methods. The divisions with remainders will be more challenging, although not impossible. Whether students answer with fractions or remainders will depend on grade level and proficiency with division and fractions.

a. 6; a stack 3 wide and colored by factor3 shows 18 is in the 6th row.
b. 2; a stack 26 wide and colored by \textit{factor13} shows 13 goes in 2 times.

c. \(5\frac{1}{2}\), or 5 remainder 1; a stack 2 wide and colored by \textit{factor2} shows 11 is 1 more than the 5th row, or \(5\frac{1}{2}\) rows.

d. 2 \(\frac{1}{2}\), or 2 remainder 2; a stack 8 wide and colored by \textit{factor3} shows that 3 goes in 2 whole times with 2 out of 3 left over.

**Q9** Answers will vary.

**Extensions**

1. As written, this activity always uses a plot of stacked, ordered, square icons. Challenge students to experiment with other types of plots that show interesting patterns. For example, this ordered fused circle colored by \textit{factor10} shows how multiples of 10 are evenly spaced throughout the numbers from 1 to 100.

![Factor 10 plot](image)

2. Have students create two plots stacked and ordered by \textit{number} and look for relationships between them. They can try two stacks of different widths colored by the same factor, or two stacks of the same width colored by different factors. Challenge students to explain why the relationships exist. For example, these two plots show that every multiple of 6 is also a multiple of 3, but only half of the multiples of 3 are multiples of 6. This is easily explained because 3 is itself a factor of 6. Students could even compare a third plot—\textit{factor2}—and see that every multiple of 6 is also a multiple of 2, but only a third of the multiples of 2 are multiples of 6.

![Factor 10 plot](image)

3. Students can begin to incorporate some of the other attributes such as \textit{even}, \textit{digit sum}, or \textit{ones digit}. Exploring how these relate to the factor attributes can introduce or reinforce many division “rules,” such as “all even numbers are divisible by 2” and “if a number ends in 0 or 5, it is divisible by 5.” The plot below illustrates the rule “if the sum of the digits is a multiple of 9, then the number is divisible by 9.”

![Factor 10 plot](image)

4. Students in grades 6–8 who are beginning to learn about prime numbers can use the stacks and factor attributes to explore the concept of prime. Because a prime number only has factors of 1 and itself, the prime numbers will never appear in the last column of a stack, except for the first row. As an example, consider 17. If you make stacks 2, 3, 4, . . ., 15, 16, and 17 wide, the only time 17 will be in the last column is when the stack is 17 wide. So the only factors of 17 are 1 and 17, and 17 is prime.
5. Students in prealgebra or algebra could write algebraic expressions for the patterns of multiples in the stack. Consider this stack that is 4 wide and colored by factor17:

```
49  50  51  52
46  47  48  49
43  44  45  46
40  41  42  43
37  38  39  40
34  35  36  37
31  32  33  34
28  29  30  31
25  26  27  28
22  23  24  25
19  20  21  22
16  17  18  19
13  14  15  16
10  11  12  13
  7  8  9 10
  4  5  6  7
  1  2  3  4
```

The first multiple of 17 is 1 more than the 4th row of 4, the second multiple of 17 is 2 more than the 8th row of 4, and so on. Students could write the sequence of numbers as

\[4 \times 4 + 1 = 17\]
\[4 \times 8 + 2 = 34\]
\[4 \times 12 + 3 = 51\]
\[4 \times 16 + 4 = 68\]

Advanced students could even generalize the sequence for the nth multiple of 17:

\[4 \times 4n + n = 17n\]
descriptions, this activity is not intended as a comprehensive introduction of the concepts. Therefore, the activity is best suited for students in grades 6–8.

This activity is rather long and may take more than one class period to complete. Because the activity is divided into three explorations—squares, triangular numbers, and primes—you could break it up over three consecutive half-days. You could also divide the activity into three completely separate activities that you do independent of each other, or you could pick and choose from among them.

A final note about vocabulary: The worksheet uses square number and perfect square synonymously. This could confuse some students. Also, the collection includes attributes called square and perfect_square. For this activity, students need to use perfect_square, which tells whether the number is a perfect square; square is a numeric attribute that gives the value when you square the number.

Plot and Investigate

Q1 Answers will vary depending on grade level and pattern-recognition skills.

In the simplest case, students should notice that the perfect squares are always in the first or fourth column. They might further notice that the perfect squares in the first column are always odd and that those in the fourth column are always even.

Some students may notice patterns in the number of cases between the perfect squares. For example, in the first column the second perfect square is 2 rows above the first, the third perfect square is 4 rows above the second, the fourth perfect square is 6 rows above the third, and so on. Furthermore, in the fourth column the second perfect square is 3 rows above the first, the third perfect square is 5 rows above the second, the fourth perfect square is 7 rows above the third, and so on. (Note: Some students may describe the separation by the number of rows between, but not including, the perfect squares, in which case they might describe the first column’s pattern as “1 row between . . . , 3 rows between . . . , etc.”)

Some students may notice that consecutive perfect squares increase by odds: “4 is 3 more than 1, 9 is 5 more than 4, 16 is 7 more than 9, . . . ” However, because this insight requires reading across the rows rather than focusing on the columns of highlighted numbers, it may be a rare response.

Note: Some students might prefer to swap the axes in order to make the plot fit the window better. This is okay, but then the patterns in the numbers go from left to right.

Q2 The first perfect square after 100 will be in the first column, 10 rows above 81. The second will be in the fourth column, 11 rows above 100. The next will be in the first column, 12 rows higher. The next will be in the fourth column, 13 rows higher. And the fifth will be in the first column, 14 rows higher. (Note: Accept any answer that gets at this insight, including sketches that attempt to extend the rectangular stack.)

Some students may recognize that the numbers in each column increase by 4 as you go up, so they might calculate the perfect squares as

\[
\begin{align*}
81 + (4 \times 10) &= 121 \\
100 + (4 \times 11) &= 144 \\
121 + (4 \times 12) &= 169 \\
144 + (4 \times 13) &= 196 \\
169 + (4 \times 14) &= 225
\end{align*}
\]
Other students might sketch an extension of the diagram and fill in or count spaces to find the numbers.

Be aware that some students may simply calculate $11 \times 11$, $12 \times 12$, and so on. Although this is an effective way to find consecutive perfect squares, it does not use the pattern illustrated by the plot.

Q3 Answers will vary, although there are two ideal answers.

First, a stack that is 2 wide shows a pattern of perfect squares alternating from side to side. If you look at the distance between perfect squares in each column, the pattern is similar to the stack that was 4 wide, except the evens and odds are not consecutive. For example in the first column, you go up 4 rows, then 8 rows, then 12 rows. Other students might notice a pattern based on alternating back and forth: “go up 1 row and right, go up 3 rows and left, go up 3 rows and right, go up 5 rows and left, go up 5 rows and right, . . .”

Second, a stack that is 1 wide (or a continuous string) shows a pattern of increasing by odds: “up 3, up 5, up 7, up 9, . . .”

Some students might start experimenting with types of plots other than stacks of rectangular icons. For example, a fused circular graph shows the increasing-by-odds pattern, too.

Q4 Plots and answers will vary. The next five triangular numbers are 15, 21, 28, 36, and 45. A good answer is that triangular numbers increase by consecutive whole numbers: “go up 2, go up 3, go up 4, go up 5, . . .” Both the single stack and fused circular graph below show this pattern. (Note: If students count the case icons between triangular numbers, the pattern starts at 1.) To help students see this pattern, you might have them go back to the geometric pattern on the worksheet and construct the next numbers in the sequence. They should see that you make the next triangle by adding a bottom row one unit longer than the previous bottom row.

Also, triangular numbers always come in pairs of odds and evens: 1, 3 (two odds), 6, 10 (two evens), 15, 21 (two odds), 28, 36 (two evens), and so on. One way to highlight this pattern is to separate the icons by triangular and then color them by even. Again, you could ask students to go back to the triangular diagrams and challenge them to explain why this happens.

Q5 Plots and answers will vary. Unlike the perfect squares and triangular numbers, the primes have no consistent patterns. Some plots will
appear to show patterns, but these patterns can’t be extended for all primes. There are some things students can say, however, about primes, such as the fact that other than the number 2, they are all odd numbers.

Two interesting stacks of square icons are 5 wide and 6 wide, as shown below. The 5-wide stack shows that the primes tend to fall on certain diagonals. The 6-wide stack shows that the primes tend to be in the first and fifth rows. (Students could investigate why this is.)

<table>
<thead>
<tr>
<th>96</th>
<th>97</th>
<th>98</th>
<th>99</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td>91</td>
<td>92</td>
<td>93</td>
<td>94</td>
<td>95</td>
</tr>
<tr>
<td>86</td>
<td>87</td>
<td>88</td>
<td>89</td>
<td>90</td>
</tr>
<tr>
<td>81</td>
<td>82</td>
<td>83</td>
<td>84</td>
<td>85</td>
</tr>
<tr>
<td>76</td>
<td>77</td>
<td>78</td>
<td>79</td>
<td>80</td>
</tr>
<tr>
<td>71</td>
<td>72</td>
<td>73</td>
<td>74</td>
<td>75</td>
</tr>
<tr>
<td>66</td>
<td>67</td>
<td>68</td>
<td>69</td>
<td>70</td>
</tr>
<tr>
<td>61</td>
<td>62</td>
<td>63</td>
<td>64</td>
<td>65</td>
</tr>
<tr>
<td>56</td>
<td>57</td>
<td>58</td>
<td>59</td>
<td>60</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>53</td>
<td>54</td>
<td>55</td>
</tr>
<tr>
<td>46</td>
<td>47</td>
<td>48</td>
<td>49</td>
<td>50</td>
</tr>
<tr>
<td>41</td>
<td>42</td>
<td>43</td>
<td>44</td>
<td>45</td>
</tr>
<tr>
<td>36</td>
<td>37</td>
<td>38</td>
<td>39</td>
<td>40</td>
</tr>
<tr>
<td>31</td>
<td>32</td>
<td>33</td>
<td>34</td>
<td>35</td>
</tr>
<tr>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
</tr>
<tr>
<td>21</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
</tr>
<tr>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
</tbody>
</table>

From having used fused circular plots for triangular numbers, some students might do the same for the primes. They might notice a slight increase in the distance between primes as the numbers get closer to 100.

**Extensions**

1. Students will likely notice that there is an attribute called *perfect_cube*. You might define *cubic numbers* and have them look for patterns in the perfect cubes. Because there are only four perfect cubes less than 100, students might have a difficult time detecting any patterns.

You may want to have students add additional cases, say for 101 to 250 (or higher), in order to see more of a pattern. *Note:* Most of the attributes in *Number Properties.tp* are calculated with formulas, so it will be very easy for students to add more cases. (Choose *New Cases* from the *Data* menu and enter the desired number of new cases. Values for all the attributes except *prime* will be automatically computed.)

2. Students will also likely notice that there are attributes called *square*, *square root*, and *cube*. These numeric attributes perform the indicated function on *number*. For students in grades 6–8 who are beginning to learn about function plots, you can create graphs of these attributes by fully separating *number* on the horizontal axis and fully separating *square*, for example, on the vertical axis. Students can study the general shape of these function curves and describe similarities and differences.

3. You may be familiar with the Sieve of Eratosthenes. Eratosthenes (276–194 B.C.) was a Greek mathematician who devised a way to “strain out” prime numbers from composites. Essentially, because prime numbers cannot be a multiple of another number, you cross out all numbers that you know are multiples of 2, 3, 4, 5, and so on. You could do the Sieve with TinkerPlots, but it is better to do it with an old-fashioned number grid on a sheet of paper. Draw a number grid, or print a stacked plot, and cross off all the multiples of 2, then all the multiples of 3, and so on, up through the multiples of 17. Students will notice that for several of the factors no additional numbers get crossed out—their factors have already been eliminated. For example, when you get to 10 you find that all its multiples have already been eliminated by its factors 2 and 5.

**Links**

You and your students can find links to information about square, triangular, and prime numbers at the TinkerPlots Online Resource Center. Choose *Online Resource Center* from the *Help* menu or go to www.keypress.com/tinkerplots.
Men’s 100-Meter Dash at the Olympics (page 32)

Activity Time: 25–55 minutes

Required Document: Olympics 100 Meter.tp from the folder Data and Demos | Exploring Data Starters. This document uses the same data as Olympics.tp in the folder Data and Demos | Sports and Entertainment.

Prerequisites: Students should have had some experience with graphs that use two axes to compare two attributes, such as line graphs or scatter plots.

This activity contains step-by-step instructions for creating the plot, so it requires little or no experience with TinkerPlots.

Students need to be comfortable ordering and estimating decimal numbers as almost all of the Olympic results are recorded with decimals: specifically, the 100-meter dash times are recorded in tenths and hundredths of a second.

Mathematics: Students will represent and summarize data with time series graphs and justify predictions based on trends in time series data.

Connections: This activity could also be used for, or in connection with, science classes, social studies classes, or physical education classes. Science instructors can use the activity as a way to engage students in the phases of scientific inquiry (ask a question, design an investigation, gather and analyze data, and formulate an answer) and as a topic of discussion regarding changes in physical characteristics over time and what may cause them. Social studies teachers can discuss the history and political and social importance of the Olympic Games. Physical education instructors can use the activity to discuss the importance of proper training for any sport, the role that records play in sports, and how the Olympics fit into the larger world of sports competition. Physical education instructors might also want to have students analyze data for their own school. For example, students could look at 100-meter dash results for the seventh-grade classes for the past 10 years or the 100-meter dash results for every grade level in the current year.

General Notes: The main focus of this activity is recognizing a trend in a time series graph and using that trend to make predictions. Specifically, students will explore how the gold-medal times for an Olympic event have decreased over time.

This activity may be challenging for students in grades 4–5 because time series graphs may be new to them. (These are the same as line graphs.) To help students for whom this is an unfamiliar representation, the worksheet has step-by-step instructions for creating the necessary plot.

This activity is well suited for students in grades 6–8 because it gives students an opportunity to recognize and describe the relationship that exists between two attributes. You could challenge older students to find a line (or curve) of fit for the data.

Think About It

Encourage students to work in pairs or small groups to write answers for the Think About It questions, or have students write individual answers and then discuss them in groups. Involving students in group discussions will foster communication, help make apparent common expectations about the data and questions, and illuminate alternative ideas.

Q1 Answers will vary depending on grade level and estimation skills. As a guidepost for answers, the Olympic data in Olympics 100 Meter.tp ranges from 9.84 to 12 seconds.

Q2 Students will likely guess that the time is shorter than in the past. Explanations may include improvements in training techniques (possibly even mentioning controversial topics such as steroids), improvements in equipment (such as better shoes), the athletes’ desires to continually outperform records, the increasing number of countries and people participating, or genetic evolution.

Plot and Investigate

For students unfamiliar with time series graphs, you might want to have them explore alternate representations of the data before jumping into steps 1–6. For example, students might find it easier to begin by looking at a value-bar plot (see the graph at the top of the next page). Here, students can use both the height of the bars and the color gradient to see that the times decrease as the years increase. This is best done as a class demonstration. Ask students to imagine putting a point at the top of each bar and connecting the points—this is exactly what the time series graph does. When students switch the case icons from value bars to circle icons, they can see the graph “morph” into the scatter plot. (Note: To see this animation, you will first need to have made the time series graph using circle icons with both attributes fully separated, as described in the activity. To improve the clarity of the animation, set the minimum of the vertical axis to 0 by double-clicking the axis endpoint and entering 0 in the dialog box. Now change the icon type to Value Bar.)
**Vertical.** You should see a smooth animation between these two plot types. When you switch again to circle icons, the plot will smoothly animate back.)

Q3 Between 1896 and 1900. This is where the greatest distance (longest segment) between two consecutive points occurs.

Students may like speculating why there was so much improvement between the first and second years of the modern Olympics. They might guess that the athletes didn’t know what to expect the first year, so training was less than adequate. They could also see if this was true of other events.

Q4 At first, many students will have trouble seeing beyond individual data to the overall trend. Students might say, “The time series graph tells me the winning time each year,” or “The graph tells me that the winning time usually changes from year to year.” Even students who have had experience with linear functions may have trouble seeing a trend because the differences are not constant—they fluctuate from year to year.

With appropriate prompting from you, all students should eventually see that the plot shows a decreasing trend overall—that as the years increase, in general, the gold-medal times decrease. Some students may be careful to qualify their observation by noting that although the overall trend decreases, there are many years when the time increased. Emphasize to students that phrases such as “tends to” or “in general” imply that there are exceptions to the pattern.

Student answers will probably vary in sophistication by grade level. Students in grades 4–5 might just say that it “goes down,” whereas students in grades 6–8 may begin to describe the trend as “linear” or “curved.” Some students might observe that 1896 is an “outlier,” and that the overall trend would look more regular if you removed that case.

Q5 Answers will vary depending on estimation skills and students’ assumptions. Reasonable answers can range from 9.80 to 9.90 seconds.

Q6 Answers will vary. Ideally, students will extend whatever trend they see to the next value, so their explanation should both summarize the trend and say how they are using it to predict the next value. Some students will instead try to guess mainly whether the new record will go up or down from the last one. Of course, there is no way to predict this for sure, though our best guess based on past results is that it will go down slightly. To help students eyeball where the next value is likely to be, suggest that they enlarge the plot, which will add more-detailed tick marks to the axes. Suggesting students look at the data in a case table may also help, as they can see all of the values at once. Students who are not proficient with decimal numbers may struggle to get a reasonable prediction.

Students may find it helpful to add horizontal and vertical reference lines. The intersection of these lines gives the coordinates of points in the plot. Some students might “eyeball” a location for the point, while others might use the Drawing tool to sketch a line or curve through the data. This sample plot shows how you could approximate 9.74 seconds for 2008. (Note: Adding reference lines slightly compresses the graph to give room for the reference values. So, students should add the reference lines before drawing a line of fit.)

Older students or those in prealgebra or algebra might use the slope between two representative points and extrapolate. For example, a student could choose (1972, 10.14) and (2000, 9.87) as points for a line that might summarize the trend. The slope is about –0.01, or a decrease of one-hundredth of a second per year. Four years from
2000, the predicted time would decrease four-hundredths to 9.83 seconds. Eight years from 2000, the predicted time would decrease eight-hundredths to 9.79 seconds.

You might have students find the actual values for years not included in the data to see how well they did at predicting. They could add this case to the data set.

Q7 Answers will vary. Explanations must include how the plot supports their answer.

If students see a strong linear relationship (as sketched in Q6), then theoretically the time will keep decreasing rather than leveling off at a best time. However, with some prompting they will see that a human could never run 100 meters in 0 seconds or a negative amount of time, so the trend will have to level off eventually.

If students see the trend more as a curve that is leveling off (as sketched below), they may propose that eventually there will be no improvement of times. Some of them might even argue that there will always be improvements as long as our time measurements get more and more refined.

Extensions
1. Students can repeat the activity looking for relationships between Year and the other track-and-field events.

Some events, notably the women’s events, were not held in every year. If students use these attributes in a plot, they may encounter excluded cases for the first time. Explain that when a case does not have a value for a graphed attribute, the case’s icon is stacked above an asterisk to the right of the plot.

2. Discuss whether environmental factors (altitude, temperature, humidity, etc.) might affect the gold-medal times and distances, and which events might be most affected. Students can make a list of conjectures and then turn to TinkerPlots to test some of them. The document Olympics 100 Meter.tp already has data about altitude; students will need to do their own research and add an attribute for any other factor they might suspect. They will probably not find data for the exact times in question (the weather in Seoul in August 1988, for example), but they can work with August averages for the cities. See the links at the TinkerPlots Online Resource Center.

3. Students in grades 6–8 could begin to explore bivariate relationships that are not time series: for example, men’s 100-meter dash times versus men’s 200-meter dash times, men’s 100-meter dash times versus women’s 100-meter dash times, or men’s discus distance versus men’s high jump distance. Students should first predict how they think the two groups will compare (“I think the 200-meter dash times will be about twice as long as the 100-meter dash times”). After using TinkerPlots to plot the data, you might suggest that students look at how the slope of a line of fit would relate to the relationship between the data (“The 200-meter dash takes about twice as long to run as the 100-meter dash, and the slope of the line of fit is 2”). Some pairs of attributes, such as the 100-meter and 200-meter dashes, will have predictable relationships that are easy to justify (“The 200-meter dash is twice as far as the 100-meter dash, so it makes sense that it takes twice as long to run it”).

4. Look at what happened to the gold-medal times and distances during periods when the Olympics were not held (during World Wars I and II). Students will find that most events suffered a setback or showed no improvement in the Olympics immediately following these gaps. Discuss factors that may have contributed to these setbacks, including lack of training during war years, lack of funding for training after the wars, or loss of athletes during combat.

Links
You and your students can find links to additional data and information about the Olympics at the TinkerPlots Online Resource Center. Choose Online Resource Center from the Help menu or go to www.keypress.com/tinkerplots.
Men and Women at the Olympics
(page 35)

Activity Time: 45–55 minutes

Required Document: Olympics Men Women.tp from the folder Data and Demos | Exploring Data Starters. This document uses the same data as Olympics W vs M.tp in the folder Data and Demos | Sports and Entertainment.

Prerequisites: Students should have had some experience with graphs that use two axes to compare two attributes, such as line graphs or scatter plots.

It is best if students have first done Men’s 100-Meter Dash at the Olympics and worked with Olympics 100 Meter.tp. Doing that activity as a prerequisite gives students experience with the Olympics data, making time series graphs, and looking for patterns in bivariate data.

Students also need to be able to add and subtract decimal numbers or, at least, to estimate the difference between decimal numbers.

During this activity, students will probably want to use color keys to help distinguish between men’s and women’s results, so you’ll need to be prepared to help them locate the Key button.

Mathematics: Students will compare related sets of data; represent data with graphs; use time series graphs to make conjectures about possible relationships between two attributes; and justify predictions based on data.

Connections: This activity could also be used for, or in connection with, science classes, social studies classes, or physical education classes. Science instructors can use the activity as a way to engage students in the phases of scientific inquiry (ask a question, design an investigation, gather and analyze data, and formulate an answer) and as a topic of discussion regarding changes in physical characteristics over time and what may cause them. Social studies teachers can discuss the history and political and social importance of the Olympic Games, as well as the political issues surrounding gender differences and equality (for example, political events that spurred the addition of more events for women, what might happen if women’s results do catch up to men’s results). Physical education instructors can use the activity to discuss the role that records play in sports, physiological differences between men and women that could account for differences in their performances and for which sports gender may not make a difference in performance. Physical education instructors might also want to have students analyze data for their school; for example, students could look at the boys’ and girls’ 100-meter dash results for the seventh-grade classes for the past 10 years or the boys’ and girls’ 100-meter dash results for every grade level in the current year.

General Notes: This activity builds on students’ ability to recognize trends in time series graphs, and has them compare the time series graphs of two different groups. Specifically, students will compare the trends of gold-medal times for men and for women in the same event.

Because of the added complexity of comparing two times series graphs, this activity may not work well with younger students (grades 4 and 5), especially if they haven’t first done the activity Men’s 100-Meter Dash at the Olympics.

For students in prealgebra or algebra, you can challenge them to find “lines of fit” for the time series graphs (although the data are probably not fit best with lines). You may even introduce the concept of systems of equations by sketching the two lines and locating the point of intersection.

Because women did not compete in every year of the Olympic Games, students’ graphs will include excluded cases. When a case does not have a value for a plotted attribute, the case’s icon is stacked above an asterisk to the right of the plot. If students have not experienced excluded cases before, you’ll need to explain them during this activity.

Think About It

Encourage students to work in pairs or small groups to write answers for the Think About It questions, or have students write individual answers and then discuss them in groups. Involving students in group discussions will foster communication, help make apparent common expectations about the data and questions, and illuminate alternative ideas.

Q1 Students will likely guess that the men’s gold-medal times are better than the women’s gold-medal times. Explanations may include that men are (stereotypically) stronger and can run faster than women, or that men generally have longer legs and can take fewer, longer strides. They may also cite experience from physical education classes, where boys are likely to have run faster than girls.

Students’ answers to “How much better?” will rely on their estimation skills and frames of reference. If students have done track-and-field
events in physical education class or after-school sports, they might cite differences anywhere from 1 to 5 seconds based on actual experience. The differences in the Olympic data overall are about 0.8 second. The differences range from 0.62 second to 1.6 seconds.

Q2 Some students might guess that the difference is getting smaller because interest in female athletics has been growing, attracting more participants and sponsors. Other students might argue that the difference is staying the same because physiological characteristics of men and women (bone structure, musculature, etc.) are not changing that much.

**Plot and Investigate**

Some students might use dot plots or box plots to explore the data. These plots don’t show differences over time, so this isn’t the ideal way to explore these questions. However, these graphs do give some sense of the overall difference in performance, and can therefore be a good place to start.

Q3 The data show that men’s times are better than women’s times in the 100-meter dash. A useful plot to support this conclusion is a scatter plot of 100Meters versus Year that is colored by Gender. Explanations might point out that for each year, the men’s case icon is lower on the plot than the women’s case icon.

Q4 Answers will vary depending on the methods used. For specific years, the differences between men’s and women’s times range from 0.62 second to 1.6 seconds.

Q5 Some students might find the difference for only one representative year; for example, the difference in 2000 (the most recent year) was 0.88 second. They could approximate the difference by “eyeballing” the graph; using reference lines; or selecting the case icons, recording the times from the data card, and actually subtracting. If students use this method, encourage them to explain why they think one particular year is representative.

Other students might find the difference for several years, say 1984 to 2000 (the most recent years), and find the median or mean of these differences. (For 1984 to 2000, the median difference is 0.880 second and the mean difference is 0.888 second.) Again, encourage students to explain why they are choosing these particular years. Some might argue that the difference, while decreasing in earlier Olympics, has begun to level off at around 0.8 second or a little higher. This is a reasonable argument.

Lastly, some students might find the differences for all of the years. Some students might even go back to the document Olympics 100 Meter.tp and define a new attribute that subtracts M_100Meters from W_100Meters. Stating the range of these differences, 0.62 second to 1.6 seconds, is an appropriate answer.

Q6 Answers will vary depending on the event chosen and the methods and plots used. Explanations must include how the plot supports the student’s conclusions.

The 200-meter dash data are similar to the 100-meter dash data: men’s times have always been better than women’s times. This is indicated by the men’s case icons always being lower on the plot than the corresponding women’s case icons. The differences for specific years range from 1.59 to 3.5 seconds.
For the high jump and long jump, the values are measures of distance, so the time series graphs show an increasing trend. For both, men’s distances have always been better than women’s distances, shown by the men’s case icons being higher on the plots. The high jump’s differences for specific years range from 0.28 to 0.43 meter; the long jump’s differences range from 1.31 to 2.12 meters.

Extensions

1. For students in prealgebra or algebra, challenge them to find linear equations that fit the men’s and women’s data for the 200-meter dash. (Remind them, however, that a line may not be the best way to summarize the trend, particularly if they believe the gold-medal times have begun to level off, or will eventually.) Graph both lines and use the graph to approximate the point of intersection. Discuss what’s important about this point (it’s when the men’s and women’s times will be equal according to their model). If students have learned formal methods of solving systems of equations (for example, substitution or elimination), have them solve the system algebraically and compare the solution to the graphical solution.

2. Discuss whether environmental factors (altitude, temperature, humidity, etc.) might affect the gold-medal times and distances, and which events might be most affected. Students can make a list of conjectures and then turn to TinkerPlots to test some of them. The document Olympics Men Women.tp already has data about altitude; students will need to do their own research and add an attribute for any other factor they might suspect.

3. Look at what happened to the gold-medal times and distances during periods when the Olympics were not held (during World Wars I and II). Students will find that most events suffered a setback or showed no improvement in the Olympics immediately following these gaps. Discuss factors that may have contributed to these setbacks, including lack of training during war years, lack of funding for training after the wars, or loss of athletes during combat.

Links

You and your students can find links to additional data and information about the Olympics at the TinkerPlots Online Resource Center. Choose Online Resource Center from the Help menu or go to www.keypress.com/tinkerplots.
The Yo-Yo Mystery (page 37)

Activity Time: 55+ minutes

Required Document: Yo-Yo Mystery.tp from the folder Data and Demos | Exploring Data Starters.

Sample Document: Yo-Yo Master.tp in the folder Data and Demos | Demos. See Extension 3 for ways to use this document.

Prerequisites: None.

Mathematics: Students will identify important (or unusual) aspects of data; justify conclusions based on data; represent data with graphs; summarize variability among data values with some measure of center; judge when a shift in a group average is probably due to chance and when it is an indicator or real change; and evaluate how well different graphical representations of the same data show important aspects of the data.

Connections: You might consider coordinating this activity with an after-school club. Because students are challenged to analyze data to determine whether a suspect is guilty of a crime, they need to be able to argue their conclusion and support it with graphs and words (debate team), convince other people that their conclusion is correct (mock trial), and do lots of data analysis, comparing many different types of plots to find the one that gives the best picture of what happened (math club). Even within a mathematics class, you could invite individuals from outside the class (other teachers, school employees, or available students) to act as a “jury” and comment on whether the students’ arguments satisfy a burden of proof.

General Notes: This is an extremely open-ended activity with no “correct” answer (except for Q1). For that reason, it is a valuable example of true data analysis. Statisticians usually make guesses based on data but never know what the “correct” answer is. In this case, we created these data ourselves, but randomly so that they are realistic. Because of this, we know that the break-in occurred at exactly 2:30 A.M. (case 195). You should not mention this to the students initially, but after they’ve argued their conclusions they can use it to evaluate how close they came.

Information from the Police Report

This section sets up a scenario about a robbery at a yo-yo factory. Students are challenged to pinpoint the time period when the robbery most likely happened and compare this with the time periods for when the prime suspect has an alibi. You may want to read this section aloud to the class and agree on the facts before going on.

Students should quickly understand that they want to find the point when the machine began performing at a slower average rate. The catch, however, is that the machine doesn’t make the same number of yo-yos each time period. The machine’s productivity fluctuates, and this “natural” fluctuation makes it harder to spot the precise moment when the average drop in production occurred. One general approach is to get some sense of how much this production varies ordinarily (before the break-in) and then use this as a guide to decide when values seem to be occurring reliably below this range. To complicate matters, the range during which productivity seems to drop off is right on the border of the suspect’s alibi, so students will need to make a judgment call about his guilt.

Because of its open-ended nature, this activity could take several hours. Once students get into the data, they may not want to stop. At the minimum, you should allow one full class period for data exploration and part of another class period for writing conclusions. If you have the time, you could make it an extended project, culminating in group presentations.

Plot and Investigate

Q1  a. 201 yo-yos were made during the previous two-minute period.
    b. This measurement was made during the fifth hour on the clock, or during the 5:00 A.M. hour.
    c. This measurement was made 548 minutes after 8:00 P.M., specifically at 5:08 A.M. It might help students to make a chart that they can use to quickly translate between elapsed time in minutes and the time in hours and minutes. From such a chart they would see that at 5:00 A.M., 540 minutes had gone by. 548 would be 8 minutes later, or at 5:08 A.M.

Q2  Answers will vary depending on the plots and statistics used. Students must explain how the plot supports their answers. As a broad guidepost for answers, students should find that the break-in happened sometime between 2:00 A.M. and 4:00 A.M. Students should try to refine their answer by narrowing the range of data from the nearest two hours, to the nearest hour, to the nearest half-hour, and so on.

Students might first try a time series graph (especially if they have done either of the Olympic Games activities). However, the
machine’s productivity fluctuates so much during normal operation that it is hard to notice a time period when the number of yo-yos dropped drastically. The production does seem lower sometime after 350 minutes, but no one case icon stands out.

Students might try using two horizontal reference lines, placing one at the known average of 210 and then eyeballing where the other one might go to fit the data after production decreased.

The graph below implies that the break-in happened during the 2:00 A.M. hour or the 3:00 A.M. hour. The cases are separated by Hour, with fused rectangular icons, and colored and ordered by Group. Notice that every hour up until the 2:00 A.M. hour has six or more “high” production periods. But beginning in the 2:00 A.M. hour the number of high production periods drops noticeably, with a corresponding increase in the number of low periods. So from this graph the 1:00 A.M., 2:00 A.M., and 3:00 A.M. hours seem likely periods in which the break-in occurred.

But it’s possible that the break-in occurred, say, 15 minutes before 3:00 A.M. If it did, the drop in average production would not be very apparent when looking at bin sizes of one hour, because during the majority of time in the 2:00 A.M. period the production would have been at the normal rate. The graph below shows half-hour intervals of Elapsed Time. (Set the bin width to 30.) There appears to be a drop from the previous average in the interval 391–420 minutes, or between 2:31 A.M. and 3:00 A.M. This suggests that the suspect is not guilty. (The document used to create the data has the break-in set to occur at exactly 2:30 A.M.)

Students may feel that there is not enough information from the graph above and probe further.

In the following graph, the hours up to 2:00 A.M. seem to be fluctuating within the band indicated by the reference lines, between 205 and 214 minutes. But production in the 3:00 A.M. hour was lower on average than anything previously seen, and production continues at a lower rate in the 4:00 A.M. and 5:00 A.M. hours. This suggests that the suspect could be guilty.

Q3 Answers will vary depending on the answers to Q2. For those students who feel that the best they can say is that the crime happened somewhere between 2:00 A.M. and 4:00 A.M., a reasonable conclusion would be that the data don’t provide strong enough evidence either to rule the suspect out or to convict him. If they can narrow the break-in time down to 2:00 A.M. to 3:00 A.M., then they should conclude that the suspect could not have done it. Some students might validly point out, however, that given these data, the break-in may have in fact
occurred after 3:00 A.M., but that by chance the production output in the prior period happened to be lower than average.

**Extensions**

1. As mentioned in the General Notes, this activity could be enriched by conducting a mock trial in which students present their arguments and graphs before a “jury” of people unfamiliar with the project. This would help further develop students’ communication and presentation skills, and provide additional motivation for choosing graphs that help tell their story fairly and persuasively.

2. You may want to hold a discussion about the possible consequences of trying a suspect without being entirely sure of his or her guilt. As part of this you could discuss common legal terms such as *burden of proof* or *reasonable doubt*. Collaborating with your school’s social studies teacher, you could even use this activity as a way to motivate learning more about the foundations of your country’s justice system.

3. You might use the document *Yo-Yo Master.tp* to create alternative data sets for students to explore on their own time. The document is set up so that you can change the break-in time and produce a new random sample of data. The document also includes a plot and instructions for a classroom demonstration that you and your students may find illuminating.